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1: Welcome

WELCOME TO groov RIO!

Opto 22's groov RIO® is an independent, intelligent Ethernet-based input/output (1/0) unit designed as
edge I/0 for industrial internet of things (lloT) applications. groov RIO solves two main problems with most
remote /O today:

«  First, instead of requiring you to specify several components (rack, power supply, bus coupler, module
types, and more), which is time-consuming, difficult, and requires significant domain expertise, one part
number is all you need. One part number includes built-in multifunction, multi-signal I/0; an 1/0
processor; power over Ethernet (PoE); and mounting without the need for a rack or chassis—all in a
compact industrial package.

«  Second, communicating data among field devices, control systems, company software, and cloud
services is no longer complex and costly, requiring PLCs, programming, and middleware. Instead,
groov RIO simplifies lloT and automation applications by including built-in processing and
communications: web-based configuration, flow logic software, efficient data communication methods,
and multiple automation and information technology protocols.

With groov RIO, you don't need a PLC, PAC, or industrial PC. You can place the unit almost anywhere, configure
it using just a web browser, and communicate data between field devices and on-premises or cloud-based
systems and software.

groov RIO offers features for a variety of applications. You can:

Place the unit almost anywhere. groov RIO operates through a wide
range of operating temperatures (-20 to 70 °C), and is UL Hazardous
Locations approved and ATEX compliant. Mount it on a DIN rail or panel.
Supply power to groov RIO and field 1/0 through the ETH1 network
interface using PoE connections, or provide 10-32 VDC power.
Simplify field connections using the 26-pin removable field connector
with spring clamp wire retention. Supports wire sizes 16 to 12 AWG.
Use web-based software to configure I/0 channels: inputs or outputs;
signals including voltage, current, thermocouple, ICTD; mechanical
relays. Over 62,000 field I/O combinations are possible in one unit.

Use intelligent features like counting, latching, clamping, and more.
Connect additional devices like a Wi-Fi adapter, a USB memory stick (up
to 32 GB), or a USB-to-serial adapter via the groov RIO’s USB host port
(you supply the additional devices).

Easily see the status of power, network, and 1/0 activity on the unit’s
LEDs.

Use embedded software to quickly set up data communications.

groov RIO User's Guide 1



WELCOME TO GROOQV RIO!

groov RIO as Edge I/0

groov RIO is primarily used as edge I/O in lloT applications. As you can see in the diagram below, edge 1/0
bridges the operations techology (OT) world of sensors and actuators, shown at the bottom of the diagram,
and the information technology (IT) world of computers and corporate software, at the top.

groov RIO's embedded software and protocol support make it possible to exchange data between these two

realms more easily and securely. Embedded software and protocol support include:

«  groov Manage—Web-based software for configuring groov RIO I/O channels, security, and
communications

«  Node-RED—Software for creating simple data flows to send data to cloud services, databases, other I/O
channels, and APIs. Pre-built nodes make flow creation easy.

«  MQTT—-Built-in support for MQTT, an efficient publish/subscribe protocol for exchanging data. Only a
simple configuration is needed to publish I/0O data and subscribe to commands as Sparkplug-B or string
payloads.

+  Modbus®/TCP—Support for the well-known industrial protocol. groov RIO acts as a Modbus/TCP slave
right out of the box.

groov RIO as Edge I/0

Ignition” i izon
BL\ SGL server Wi webservices Ignition"’
aa>  H1BMcloud R o %CM%
S O Google Cloud atMQTT m g’%;‘;:
On Premises In the Cloud On Devices
‘ p N CORPORATE NETWORK
SOFTWARE ﬁ
groov RIO acts as edge I/0 to
2] cyrarvs exchange data between OT field
) = L° /4% % 4 .
g"wlalg ‘?’ Sqarkplug RIO devices (at bottom) and IT
MANA amarT s computers and software (at top).
#odbus

ANALOG - DIGITAL
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CHAPTER 1: WELCOME

groov RIO as Remote I/0 in an Opto 22 Control System

In addition to its use as independent edge I/0 for lloT applications, groov RIO can also be used as remote /0

with an Opto 22 groov EPIC® processor or SNAP PAC controller. The diagram below shows RIO used with
groov EPIC.

groov RIO is wired to field devices and acts as an I/0 unit within the EPIC's control and I/0 network. As an I/0
unit, groov RIO is compatible with any of the EPIC's programming methods—PAC Control, CODESYS and IEC
61131-3 languages like Ladder Diagram and Function Block Diagram, or languages like C/C++ or Python to
build custom control programs. If you have a custom control program, you can access groov RIO using its
OptoMMP memory map addresses or via REST APIs.

groov RIO as Remote I/0 in an Opto 22 Control System

/
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WELCOME TO GROOQV RIO!

groov RIO with Modbus/TCP or Custom PC-based Control Programs

groov RIO can also be accessed by Modbus/TCP masters and by PCs running custom-built control programs:

Modbus/TCP—Because groov RIO is a Modbus/TCP slave out of the box, you can use your favorite
Modbus/TCP master device or software to poll RIO's I/O channels.

C++ or .NET and free SDKs—With your favorite development tool and our free SDKs, you can
programmatically access I/0 values on a groov RIO unit by accessing the OptoMMP memory map locations of

each channel.

HTTP/S, JSON, and REST APIs—Opto 22 provides REST APIs for groov Manage, which you use to access the
/0 values on a RIO unit. A Swagger APl document is built into RIO to quickly access REST API calls and

evaluate responses.

groov RIO with Modbus/TCP or Custom PC-based Control Programs

4
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CHAPTER 1: WELCOME

REQUIREMENTS

Power Requirements

There are two ways to provide power to a groov RIO:
« Anexternal 10to 32V DC power source or supply capable of providing at least 10 Watts
«  Power over Ethernet (PoE) through the ETH1 port (star topology only)

Field Device Wiring

Connect field devices to groov RIO with wire of size 28-14 AWG. Keep the wires as short as possible.

Software Requirements

If you are using groov RIO as an independent edge |/0 unit, all you need is a web browser to configure 1/0,
security, and networking, and to create Node-RED flows.

If you are using groov RIO as remote I/0 with an Opto 22 system running:

«  aPAC Control strategy, you need to run PAC Project 10.3000 or higher. If you are running a PAC Control
strategy on a:
- groov EPIC processor, you need GRV-EPIC-PRT firmware version 2.0.0 or higher.
- SNAP PAC controller, you need firmware 10.3a or higher.

«  aCODESYS application, you need CODESYS Development System, V3.5 SP15 Patch 1 or newer (32-bit
version) with Opto 22 Library Package for CODESYS Development System version 2.0.0.0 installed.

ABOUT THIS GUIDE

This user’s guide shows you how to mount your groov RIO, how to connect field devices, how to configure the
I/O channels, and much more.

What's In This Guide?

Chapter 1: Welcome describes groov RIO and how this document is organized.

Chapter 2: Mounting and Connecting a groov RIO describes all the requirements for supplying power,
plus instructions on mounting and wiring a groov RIO.

Chapter 3: Initializing a groov RIO describes what to do after you power up your groov RIO, which includes
creating the first user ID, which as administrator privileges.

Chapter 4: Navigating groov Manage describes how to navigate through groov Manage and find some
important information.

Chapter 5: Start to Finish—Transmit, Log, and Visualize describes how you could get data that your RIO
is collecting into a simple HMI, logged into a file, or transmitted (published) to an MQTT broker (and, therefore,
MQTT clients that subscribe to your RIO’s data) without writing a single line of code.

Chapter 5: Controlling Access to groov RIO describes how you configure RIO to limit what services can
connect to it.

Chapter 6: Connecting groov RIO to a Network or Multiple Networks describes all the factors to
consider when you connect a RIO to a network, from a single, simple network to a complex set of networks.

groov RIO User's Guide 5



SERVICE AND MAINTENANCE

Chapter 7: Configuring a groov RIO describes what to do after you finish initializing groov RIO, which
includes setting date, time, and time zones; attaching USB devices, and enabling Node-RED.

Chapter 8: Configuring I/0 describes how to select the functions (input or output), signal types (discrete,
analog), and any corresponding features for each channel through groov Manage. It also describes where to
find information if you want to write a PAC Control strategy or custom application can access your RIO.

Chapter 9: Enabling MQTT introduces you to MQTT, how it works in RIO, and how to configure it.

Chapter 10: Developing Node-RED Flows describes what an experienced Node-RED developer needs to
know to start writing flows that access RIO’s data, as well as provide step-by-step instructions for those new to
Node-RED.

Chapter 11: Maintaining a groov RIO describes all the tasks you can do to keep your RIO performing
smoothly, how to install firmware updates, perform periodic backups, review guidance to do basic
troubleshooting, information to collect should you need to contact Product Support, and an overview of how
to conduct an OptoRSS (Remote Support Service) session.

Appendix A: Specifications lists the specifications for each channel of a RIO, as well as the specifications
common to all channels on a RIO.

Appendix B: Wiring Diagrams lists all the wiring diagrams for a GRV-R7-MM1001-10.

Appendix C: groov RIO Explorer describes our online app that helps you see different combinations and
arrangements of channel configurations, help you choose combinations and arrangements that are valid, and
create wiring diagrams for your chosen combination.

SERVICE AND MAINTENANCE

To keep your groov RIO up-to-date with the latest firmware fixes and features, you'll want to regularly check for
and apply maintenance, as described in “Updating Firmware on a groov RIO" on page 96.

If you encounter any problems with your groov RIO, follow the instructions in “Collecting Information for
Product Support”on page 103 before contacting Opto 22 Product Support.

Service (Product Support)

If you are having problems installing or using groov RIO products and cannot find the help you need in this
guide or on our website, contact Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 toll-free NOTE: Email messages and phone calls
in the U.S. and Canada) to Opto 22 Product Support are
951-695-3080 grouped together and answered in the
Monday through Friday, order received.
7 a.m.to 5 p.m. Pacific Time

Fax: 951-695-3017

Email: support@opto22.com

Opto 22 website: WWw.0pto22.com
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2: Mounting and Connecting a
groov RIO

GATHERING YOUR EQUIPMENT AND INFORMATION

Gathering up all the supplies, information, and equipment you need before you mount, connect, and initialize

your groov RIO can help get your unit up and running more quickly:

«  Anaccessible power source that complies with the requirements described in “Power Requirements”on
page 5.

«  The proper gauge wires to connect the groov RIO to your field devices as described in “Field Device
Wiring”on page 5.

«  Penand paper to note important information that you might need during this process or to keep for
future reference.

«  The spring clamp tool that ships with your groov RIO, which helps you connect field device wires to the
correct pins on the terminal connector.

In addition, make sure you have a list of all the 1/0 channels (sometimes referred to as points) that you need
set up. This might be in a form of a document that maps which channels will connect to a specific field
device/point. If you are working with a terminal strip, review the terminal number assignments, making sure
you understand which terminal numbers are assigned to specific channels.

If you are connecting multiple groov RIOs, you'll need to determine if you are connecting themin a
daisy-chain formation or star formation.

After you assemble your unit, you'll initialize it as described in “3: Initializing a groov RIO"on page 15. After you
finish initializing the unit, it will be ready to run.

Familiarizing Yourself with groov RIO

Take a look at the groov RIO unit now and familiarize yourself with its features., shown in the diagrams on the
following page. You can always come back and review these diagrams when you need to.

groov RIO User's Guide 7



GATHERING YOUR EQUIPMENT AND INFORMATION

groov RIO: Front View

Reset switch

Power LED

Status LED

ETHO LED
ETH1 LED

Discrete channel
indicators

92 G2 ¥Z €22 12 0Z 61 8L Z1-9%

Power supply
connectors

T

groov RIO: Bottom View

USB port

Switched Ethernet ports (2):
ETHO

ETH1 (provides Power over
Ethernet (PoE)

Power supply
connectors
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LEDs

LED

POWER

STATUS

ETHO,
ETH1

Indicates

The status of power.
+ Solid green—RIO is powered on.
+ Solid red—RIO is restarting.

Whether RIO is running or resetting.

+ Solid green—RIO is running normally.

+ Blinking green—RIO is starting (power on) or restarting (ini-
tiated by Reset Switch).

+ Blinking between green and red—RIO is resetting to factory
defaults.

Network connection speed and whether there is any trans-
mission activity:
+ Solid green: 1Gbps; transmission activity = No
« Blinking green: 1 Gbps; transmission activity = Yes
« Solid orange: 10 or 100 Mbps; transmission activity = No

+ Blinking orange:10 or 100 Mbps; transmission activity = Yes

— Terminal connector

groov RIO: Back View

Extendable tabs for
panel mounting

DIN rail adapter

Extendable tabs for
panel mounting




MOUNTING

CHAPTER 2: MOUNTING AND CONNECTING A GROQV RIO

You can mount groov RIOs onto DIN rail or onto a panel.

Before mounting, make sure that there is a minimum of 2 inches clearance
on the top, and 1 inch clearance on the bottom, on each side, and in front
of RIO after it is mounted. Mount RIO as shown in the diagram: with the
Opto 22 logo at the top. Compliance with these guidelines will help ensure
that the groov RIO performs as described in the specifications.

Mounting on DIN Rail

Before mounting your RIO:
o Ensure that the vents around RIO are not obstructed.

«  Ensure that the mounting location meets the clearances described
above.

The groov RIO is built with DIN rail adapters for use on 35 mm DIN rail. No
additional assembly is required.

To mount RIO to a DIN rail, follow these steps:

1. Hold RIO so that the Opto 22 logo is at the top and at an angle such
that the top of the DIN rail adapter is away from the DIN rail and the
bottom of the DIN rail adapter can slide behind the bottom lip of the
DIN rail. See the circled area in the image below.

2 inches

1in.
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MOUNTING

2. Push the bottom part of RIO upward, making sure that you feel the clip catch on to the rail, and
simultaneously push the top half of RIO toward the DIN rail until the top of the DIN rail adapter engages
the top lip of the DIN rail.

Before you release RIO, verify that the top and bottom of the DIN rail adapters have engaged the DIN rail.

Mounting on a Panel

Before mounting your RIO:
«  Ensure that the vents around RIO are not obstructed.
«  Review the clearances requirements described in the previous page.
1. First, extend the mounting tabs:

a. Turn the RIO so you can see the backside.

b. With a small Phillips screw driver, remove the
screw on one tabs.

c. Slide the tabs out so the middle hole on the tab
aligns with the screw hole on the RIO.

d. Reinsert the screw to the torque indicated in the
“Common Characteristics” section of the
specifications (see “Specifications”on page 109).

e. Repeat steps b through d with the other tab.

To mark holes on the panel and verify placement before attaching the RIO, use the RIO as a template.

3. Attach the RIO to the panel with screws (not provided).
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CONNECTING FIELD DEVICES

Because you can configure each channel to be an input or an output, as well as different signal types, it is very
important that you determine how each channel will be configured before you start wiring field devices to
the pins. Forimportant information and guidance on selecting channel configurations, see”Selecting
Functions, Signals, and Features”on page 59.

Wiring Field Devices to groov RIO

Before you begin wiring, do the following tasks:

CAUTION: For electrical safety, turn off power to the groov RIO and de-energize field devices wired to the terminal
connector before starting.

Terminal connector screw

Select the appropriate wire. The terminal connectors are rated for 28—14 AWG wire. If you're using
stranded wire, you can make an easier and better connection by tinning the strands or adding ferrules.
Ensure that you have the spring clamp tool supplied with your groov RIO.

If you are unfamiliar with the names of some of the parts of the groov RIO, review the diagrams on
page 11.

It may be easier to insert wires if you remove the terminal connector from the RIO. To remove the
terminal connector, loosen the terminal connector screw at one end of the connector, then pull the
connector straight out to remove it from the groov RIO.

If you have never used a spring-clamp wiring system, take a moment to familiarize yourself with the
diagram below. The clamp release hole is where you will insert the sprint clamp tool. The field wiring hole
is where you will insert your field wires.

If you look into the field wiring hole, you will see a highly reflective surface. If you can see that surface,
that means that the clamp is closed.

In this example, pin 2's clamp release hole and corresponding
field wiring hole are open.

Pin numbers

!I!lq| —Field wiring holes

EENEEE.
LLLLL Clamp release holes

Spring clamp tool

Follow these instructions to connect your field wires to the terminal connector:
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CONNECTING POWER SUPPLY

CAUTION: For electrical safety, turn off power to the groov RIO and de-energize field devices wired to the terminal
connector before starting.

1. Orient the groov RIO or terminal connector to match the wiring diagrams. To make it easier to handle the
spring clamp tool and the field wires, secure the groov RIO or terminal connector by doing one of the
following:

- Ifyou are working with the terminal connector while it is attached to the groov RIO, make sure the
groov RIO is attached securely to the panel.

- Ifyou are working only with the terminal connector, secure the terminal connector with a clamp.
2. Slide the spring clamp tool into the clamp release hole, along the left side, until you feel the end begin to
meet some resistance. Gently push the tool in a little more, until you feel it stop.
- Look into the field wiring hole. If it is dark, the clamp is open. You can go to the next step.
- Ifyou can still see the highly reflective surface, gently pull the tool’s handle to the left until you feel it
stop. Hold the tool in that position. Look into the field wiring hole. If it is dark, the clamp is open. You
can go to the next step.

3. Insert the wire into the field wiring hole until it meets complete resistance. Then pull out the spring
clamp tool.

4. Test that the wire is secure by gently pulling on it. If the wire pulls out, repeat steps 2 through 3.

To remove a wire, push the spring clamp tool into the clamp release hole as described in step 2 above, and
then pull the wire out.

CONNECTING POWER SUPPLY

12

As mentioned in “Power Requirements”on page 5, there are two ways to provide power to a groov RIO.
«  Anexternal 10to 32V DC power source or supply capable of providing at least 10 Watts
«  Power over Ethernet (PoE, 802.3af Class 0) through the ETHT network interface (star topology only)

External Power Source or Supply

If you choose to supply power with an external power supply, Opto 22 recommends you connect the supply
with wire size 22-14 AWG. Keep the wires as short as possible.
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POWER SUPPLY

After you connect the external power source or supply, connect the Ethernet cable, and proceed to Chapter 3:
Initializing a groov RIO.
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Power Over Ethernet

If you choose to supply power with an Ethernet cable through the ETH1 network interface, Opto 22
recommends you use a Power Sourcing Equipment (PSE) that supports IEEE 802.3af and has sufficient power
available for all the powered devices (PDs) connected to it.

The groov RIO begins to power up as soon as the Ethernet cable connects ETH1 on the RIO to a PoE PSE device
(for example, a PoE compatible Ethernet Switch or injector). Then you can proceed to Chapter 3: Initializing a
groov RIO.
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3: Initializing a groov RIO

After you connect your groov RIO to a power supply and a network, it runs through its start-up sequence,
which includes obtaining an IP address from the DNS server on the network.

If your network uses DNS and DHCP to assign and manage IP addresses, you can start with step 1
(below).

If your network does not use DNS and DHCP to assign and manage IP addresses, you will need to install
and run (on a Windows machine) groov Find. (Make note of the IP address that groov Find identifies for
your groov RIO for future reference.) Then you can go to step 3 (below) and use the IP address instead of
the host name. If you are not familiar with groov Find, see “Downloading and Running groov Find”on

page 100

Your first tasks will be to log into groov Manage, create the first administrator account, determine if you need
to run Quick Start, and check whether you have the latest firmware installed.

1.
2.
3.

Wait for the STAT LED to stop blinking and show a solid green color.
From a computer or mobile device connected to the same network, open up a web browser.

Inthe URL bar, enterhttps://<RIO default hostname>, where
<RIO default hostname> isthe host name listed on the label on the side of unit.

- MAC: 00-A0~3D—04-80-2A
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The Welcome! screen appears on the browser window.

Welcome!

RIO

Let's get started! ©

Hostname

EthO IP Address

If, after a few minutes, you do not see the Welcome! screen or you can get an error from the browser,
check “Browser Reports that URL to RIO is Unreachable” on page 99.

4. C(lick Let's get started! (). You'll see the Create
an Account screen.

Read the information in the warning box. This first
administrator account is very important because it
provides administrator privileges over the groov RIO,
which gives you access to all the functions you need to
configure it, maintain it, and create other accounts.

It's also important to remember the username and

Create an Account

First, let's create your administrator account.
Please set your credentials below.

password to this account. The groov RIO does not provide Username

a way to recover this password nor an alternate way to | |
access this account if you forget the password. Also, Password

Opto 22 cannot recover this password or provide access | |
to the account. ConFirm Password

5. Typeina user ID and password for this administrator |
account, then click Create Account.

Itis a good idea to follow best practices regarding
passwords (for example, mixing cases and including
numbers) when you create your password. Your
password must be a minimum of 1 character and can be
a maximum of 128 characters.

=) Create Account
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6. groov Manage displays a screen with these options:

8.
9.

Great! You're ready to go.

Your account has been created. You're now ready
to set up this device.

© Quick Start % Configure Device

- Quick Start—The quick start provides a list of suggested configuration steps that you should
complete first to get your groov RIO up and running. You may want to choose this option if this is
the first time you configure a groov RIO. If you select this option, go to the next step.

- Configure Device—If you select this option, groov Manage displays the Home page, where you
can make any configuration changes. You may want to choose this option if you have configured a
groov RIO before or you feel confident you have all the information and understand the technology
and software installed on the RIO to complete any configuration steps. If you select this option, skip
to step 8.

Click Quick Start. groov Manage displays the Quick Start page.

< Help Quick Start

Here are items you'll likely wank ta review or configure Firsk.

«a Networking

the network settings, such as hostname, IP >

more,

38 Accounts

Create additional user accounts.

change the time settings, such as the current time and >

# Home
Go to the Home page.

The boxes are organized to suggest an order in which to complete the configuration. However, you do
not have to follow this order nor do a configuration task for every box. Here's why you might want to
complete each step:

- Networking—You might want to configure or change networking settings because you want to
change the IP address or hostname that was assigned to the unit. You might want to set the IP
address manually (which would make it a static IP address) or disable a network interface.

- Accounts—You might want to create additional accounts as required by the design of your site.

- Time—You can choose between manually setting the date and time, selecting a time zone from a
list, or selecting a time server that will synchronize your unit’s date and time with that time server’s
date and time.

After you finish each configuration task, click back to return to the Quick Start page.
In groov Manage, click the menu button (E), then select Info and Help.
In the Info and Help page, click About.

10. In the groov RIO section, note the version in the System Version field.
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11. Log on to opto22.com and enter the part number for your groov RIO in the Search box. Select the search
result that includes “Firmware”as part of the title; for example GRV-R7-MM1001-10 Firmware.
12. Note the firmware version number listed on the page.

- Ifthe version number on the web page is the same as the version number you noted in step 10, you
have the latest version of firmware installed on your groov RIO. You can continue on to selecting the
functions, signal types, and features for each channel and configuring groov RIO.

- If the version number on the web page is larger than the version number you noted in step 10, you
need to update the firmware on your groov RIO. Follow the instructions in “Updating Firmware on a
groov RIO"on page 96. After you update the firmware, you can continue on to selecting the
functions, signal types, and features for each channel and configuring groov RIO.
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4: Navigating groov Manage

When you connect to groov RIO through a web browser on a computer, you navigate through the web
browser in much the same way you navigate through any other web application on your computer. You can

clickonn

UNDERSTANDING TH

avigation aides like the navigation bar or links, and scroll up and down with a mouse.

E PAGE NAVIGATION AIDS

The diagram below identifies some of the important page navigation aids:

groovmnace = VSN aroovnanace

Files Done C B £ Channels Channel 5 Configure
B £ Back Directory Name
Path [home/dev/secured/ Module Type GRV-R7-MIM1001-10

X UploadFile Channel Type 5-30 VDC

Simple Digital Input

Dir Listing Refresh State m
[ logo-rio-red-grey-569x197.png

[ ri

o.bxt :?D Quality
>

O temperature_log-1.csv

Fast Updates
Updates this view very quickly, but may affect system performance.

Menu button (E)‘ Click or tap on this button to access a list of important pages. This button can
help you quickly jump to these pages.

Cancel or previous page. The upper-left area of the page provides a way to cancel any changes you
might have made to fields on the current page, return to the previous page, or both.

Save, Configure, or Done. If there are settings on the page that you can change, the upper-right area
of the page displays the word Configure. Click on Configure to open up the page where you actually
make the changes.

If this area shows the word Save, you must click on it to save any changes you made to settings on
the page. If, after saving, the processor must restart an application or service, it displays a message to
let you know.

If this area is blank, that means you can't make any changes to this page.

Links. When you see these arrows, it indicates that clicking or tapping on the arrow will open another
page that displays more information and provides more functions related to the item. For example,
when you click Project Management in the Node-RED page, groov Manage displays another page
with information and functions to help you manage a Node-RED project.
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LEARNING HOW INFORMATION IS ORGANIZED IN groov MANAGE

At the top of the groov Manage page is a navigation bar that always remains visible as you navigate through
the screens. This navigation bar contains a menu button (E) that gives you quick access to the most
frequently visited screens of groov Manage:

GroOVMANAGE = GroOVMANAGE

Home

£ I/O Channels | £ 1/O Config

Home

£ 1/0 Channels /o

System
# 1/0 Tools

& 1/0 Tools & 1/0 Reference

&% Node-RED

Info and Help

€ Node-RED 28 MQT ..

Navigation bar, with the menu button closed.

Navigation bar, with the menu button open.

«  Home, the main page of groov Manage.

« 1/0, the page that displays a visual representation of channels on the RIO unit.

«  System, the page that displays functions to help you configure system-level settings, like network
settings, time zone settings, file manage, and the ability to restart RIO.

« Info and Help, the page that gives you access to more information about RIO, like RIO unit log files, RIO
unit information, on-board documentation, firmware versions, as well as a way to access the Quick Start
page.

«  User, the page that displays the user name of the current user and the fields to change the current user’s
password.

Navigating Through groov Manage on a Computer or Mobile Device

You can navigate through groov Manage on a computer or mobile device in much the same way you navigate
through any other web application. You can Drag-and-drop—a feature commonly used on a computer to
visually and easily move files from one location to another. You can drag-and-drop files into groov RIO on any
groov Manage page with an upload button.

FINDING INFORMATION ABOUT I/0 CHANNELS

To view information about and making changes to channels, you access I/0 Channels page of groov Manage.
To reach that page, log into your groov RIO with a user ID that has administrator privileges and then do any of
the following:

«  C(lick or tap on the menu button (E), then select /0.

« Inthe Home page, click or tap on I/O Channels.
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Either action displays the 1/0 Channels page. The page displays a table where each row is a channel.

< Home 1/O Channels
0 Input Zero
A— siintiamm — B >
1 Input_One »
DO ON
2 Temp_One >
Al 66.870 DegreesF
3 Temp_Two >
Al 67.495 DegreesF
4 < N0 Name > >
DI OFF
F < Nnoname > b3
A The grey box shows the channel number at the top, the function and signal type on the bottom.
B For each channel, this area shows the channel name (if one has been assigned) at the top and a

summary of the signal information on the bottom. The summary varies; it could be the state of a
discrete input or output, the temperature reading from an ICTD probe, or quality indication.
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5: Controlling Access to
groov RIO

PART OF AN OVERALL SECURITY SYSTEM

When you control access to groov RIO, consider it as part of a total security system that includes other best
practices you might want to implement; for example, requiring that authorized users change their passwords
every three months or securing the control equipment in a locked cabinet with keys accessible to a limited
number of personnel.

IMPORTANT: groov Manage does not provide timeout-based logout. You must implement the important
practice of always logging out of any ID that has administrator privileges to prevent unauthorized access to RIO.

CREATING USER IDS AND CONFIGURING THEIR ACCESS

With groov Manage, you can create user IDs and limit access to RIO functionality and features. Before you
create a user ID, consider the following questions:

«  How many users do you want to create?
«  What functions do you want the users to access?
«  How will you secure (encrypt or password-protect) the information about the users?

Choosing Access Levels for Users

The following information can help you determine what access to give a user and what level of access to give
a user for a particular service or feature:

«  Aunit-wide administrator can do the following:
- Create other user accounts
- Access all services running on this unit
- (Change the passwords of other accounts
- Signout any and all users currently logged into this unit
- Change unit-wide settings like network, I/0, time and date, etc.

«  groov Manage—groov Manage is an administrator-level function, so if the user is a unit-wide
administrator, they have access to groov Manage. If the user is not a unit-wide administrator, they do not
have access to groov Manage.

o Node-RED—Access to Node-RED is either Editor or Off. For unit-wide administrators, Editor is the
automatic and only access level. For all other users, you can set the access level to either Editor or Off.

o PACREST API—Access to the PAC REST APIs can be one of the following:
- Read-Write
- Read-Only
- None
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Creating User IDs

After you consider what types of users you want to create and what they will have access to, do the following:
Log into your groov RIO with a user ID that has administrator privileges.

Click Accounts.

Click Add (in the upper right corner).

Type in the required information and select the permissions you want that user to have.

Click Save (in the upper right corner).

e wNn =

Repeat these steps for every user account you want to create.

MANAGING THE SSL SECURITY FEATURES OF YOUR groov RIO

24

The SSL security features on groov RIO help you establish secure communication between RIO and web
browsers, servers, brokers, and cloud services.

Learning How SSL Works on groov RIO

If you are not familiar with SSL, you might want to spend some time reading the following OptoBlog,
Understanding SSL/TLS and HTTPS.

Each groov RIO comes with a unique certificate (called a self-signed, server SSL certificate) to enable
communication between its internal web applications (like groov Manage and Node-RED) and web browsers
on computers and mobile devices. When you connect to groov RIO through a web browser for the first time,
the browser displays a warning message that the site (in this case, your groov RIO) is untrusted. To avoid the
warning, you can install the self-signed, server SSL certificate into the certificate store of the web browser.
Afterwards, the browser will “trust” your RIO (the site) and no longer display that warning.

Creating a Self-Signed Certificate

Log into your groov RIO with a user ID that has administrator privileges.
Click Security > Server SSL > Create Certificate.

3. Inthe Create Certificate page, enter the information requested.
Server Name—tEnter the fully qualified domain name or IP address of this groov RIO that others will use
to access it. The server name may contain letters a-z (case insensitive), digits 0-9, or a hyphen (-). No
other characters are allowed. The server name must not start with a hyphen.
Example:
If the URL that others will use to access the RIO is https://process1.acme.com, then type in
processl .acme.com
Example:
If the URL that others will use to access the RIO is https://mobilehmi.mydomain.com, then type in
mobilehmi.mydomain.com
Email—The email address of the individual in your organization requesting the certificate and who
would be responsible for responding to any inquiries about this certificate.
Department—Information to differentiate between divisions within an organization. For example,
“Engineering”or “IT" If applicable, you can enter the DBA (doing business as) name in this field.
Organization—The legally registered name of your business. The listed organization must be the legal
registrant of the domain name in the certificate request. If you are enrolling as a small business or sole
proprietor, please enter the certificate requester’s name in this field, and the DBA (doing business as)
name in the Organizational Unit field.
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City or Locality—Name of the city or locality where your organization is located. Please spell out the
name of the city or locality. Do not abbreviate.

State—Name of state, province, region, territory where your organization is located. Please enter the full
name. Do not abbreviate.

Country Code—The two-letter International Organization for Standardization (ISO-) format country
code for the country in which your organization is legally registered. See
http://www.digicert.com/ssl-certificate-country-codes.htm for a list of codes. For example, the code for
the United States is US.

Days until expiration—Enter the number of days before the certificate is expired and has to be
replaced. Opto 22 recommends 3560 (10 years).

RSA key size—Enter the size of the RSA key. The default size of 2048 is a generally recommended value.
Higher values will take longer to create.

Click Create. groov Manage immediately installs the new private key and certificate, and then restarts
groov Manage.

Your groov RIO now has new copies of the Public Certificate, Private key, and CSR, which you can download
when you need to request a CA-signed certificate.

Switching to a CA-signed Certificate

When you switch to a CA-signed certificate, consider the following:

The cost of a certificate from a certificate authority ranges from free to $300 or more, depending on the
features and company you buy them from. Please work with your IT department before you begin this
task.

You will send the CSR to the certificate authority of your choice. The certificate authority verifies the
identification information and signs the CSR, which then becomes a CA-signed certificate. That's why it is
important that you enter accurate information in step 3 of “Creating a Self-Signed Certificate”on page 24.

If you have not created a self-signed certificate, do that first. See “Creating a Self-Signed Certificate”on

page 24.

1. Loginto your groov RIO with a user ID that has administrator privileges.

2. Click Security > Server SSL > Download CSR.

3. Navigate to a folder where you want to store the CSR file. Make a note of the file name and path to the
folder. Click Save.

4. Go to the certificate authority (most likely a web site) and provide them with the information they
request in whatever format they request.
When filling out a form for a CA-signed certificate, keep in mind that an SSL certificate works with any
operating system. If you are asked to select an operating system, select “other”if it an option. It's OK to
select a specific operating system, if necessary.

5. Finish the transaction with the certificate authority and receive your new SSL certificate.

6. Upload the new SSL certificate to your groov RIO:

a. Return to the View Certificate page. (See steps 1 and 2.)
b. Click Upload Certificate.

c. Click Public Certificate.
d

Navigate to the folder where you stored the new SSL certificate. Click Open. groov Manage uploads
the file and then displays the Upload Certificate page.

Click Private Key.

Navigate to the folder where you stored the private key file. Click Open. groov Manage uploads the
file and then displays the Upload Certificate page.

g. Click Upload (in the top right). groov Manage displays a message that it must restart. Click on Reload.

o

After groov Manage restarts, you can begin working with services that requires a CA-signed certificate.
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Uploading a Public Key Certificate

There are several reasons you might need to upload a public key certificate:

»  Toenable secure client/server communication (with HTTPS or TLS/SSL) between your groov RIO (acting
as client) and a PAC Control strategy or a Node-RED flow (acting as a server).

«  Toenable secure communications through Sparkplug.

To upload a public key certificate, you must make sure that it is stored on a computer or mobile device that
can connect to your groov RIO.

1. Loginto your groov RIO with a user ID that has administrator privileges.

2. C(lick Security > Client SSL.

3. Inthe Public Certificates window, click Add/Update.

GreOVMANAGE =

< Back Public Certificates

To use HTTPS or TLS/SSL From a PAC Control strategy or a Node-RED flow, you may
need to install a public key certificate. This is most commonly required when using
a self-signed certificate in the server.

For Node-RED, the certificates are located in the fusr/libfssl/certs/ directary.

Certificates Add/Update

No certificates are installed.

4. Navigate to the folder where you stored the certificate and select the certificate (pem) file.
5. Click Open. groov Manage uploads the file and you'll see it listed in the Certificates section.

GroCVMANAGE =

€ Back Public Certificates

To use HTTPS or TLS/SSL from a PAC Control strategy or a Node-RED flow, you may
need toinstall a public key certificate. This is most cammonly required when using
a self-signed certificate in the server.

For Node-RED, the certificates are located in the fusr/lib/ssl/certs/ directory.

Certificates Add/Update

csr.pem >

If you need to upload another certificate, repeat steps 3 through 5.

Changing SSL Security Features for Sparkplug

If you are using Sparkplug with MQTT to publish data from groov RIO, you must first create and install a
CA-signed Certificate on RIO.

«  Forinstructions on creating the certificate, see “Switching to a CA-signed Certificate” on page 25.

«  Forinstructions on installing the certificate on the processor, see “Uploading a Public Key Certificate” on
page 26.

After you installed the certificate(s):

1. Loginto your groov RIO with a user ID that has administrator privileges.

2. Click MQTT > Configuration.

3. Foreach MQTT Broker that you have listed on the MQTT page and for which you want to enable SSL:
a. Click the broker name to open its MQTT Broker settings window.
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Move the slider to the right so that it shows green (@l ) ). groov Manage displays a new row
below the SSL row.

I MQTT Broker I

4 Broker URL https://www.example.com:1883
Client ID exampleMQTTclientlD
Username jdoe
Password s
ssL &

CA Certificate Select Certificate

Select the certificate authority PEM certificate. You can upload the CA certificate from
Manage -> Security > Client SSL.

ConnTimeout (ms) 5000

Keep Alive (s) 10

Cancel Delete oK

Device ID Example_Device_ID

Click Select Certificate. groov Manage displays the CA Certificate window with a list of public key
certificates installed on the processor. Select the certificate you want.

CA Certificate

+ Select Certificate

cert.pem

Cancel

"3Sr

CA Certificate Select Certificate

groov Manage refreshes the MQTT Broker settings window to show the name of the certificate you
chose.

Click OK.

When you are done modifying all the MQTT Brokers that you wanted to change, click Save.

If there are any errors in any of changes you made, groov Manage highlights the broker with the error in red.
Select that broker to view more information about the errors. Make any necessary changes and try saving
again.

CONFIGURING THE FIREWALL

You might be accustomed to hearing or reading about firewalls to protect corporate networks, home
networks, and even individual computers. groov RIO also contains firewall technology to protect it from
unauthorized connections and communication.

Before you configure the firewall on RIO, make sure you understand the following:
Firewall rules and how they work.

If you need to create a new rule, you need to know the protocol you want to select (TCP, UDP, or both)
and the port number, or range of port numbers, to which this rule will apply.

The default firewall rules. These rules are in the firewall as part of the default factory settings.
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Creating a Firewall Rule

When you make changes to the RIO’s firewall, the changes take effect immediately. So, make sure you
schedule this change during a time that minimizes the impact to your system and users. If necessary, notify
your users of this change so they can plan accordingly.

To create a new rule for the firewall:

1. Loginto your groov RIO with a user ID that has administrator privileges.

2. (lick Security.

3. Click Firewall. The Firewall page displays the rules currently in effect and may look similar to this:

< Cancel Firewall Save

groov RIO

Ports: 80,443 >
Allow: eth0,wlan0,tun0

OptoMMP

Ports: 2001 >
Allow: eth0,tun0

Deny: wlan0

ModbusTCP
Ports: 8502 >

Allow: eth0,tun0
Add Rule

Deny: wlan0

[

4. C(lick Add Rule. Type in information for the new rule:

- Title—This will display as a new section title, which has limited space. A title of less than 30
character fits well in the space.

—  Protocol—Select which protocol this rules applies to.

- Port—Type in the port number or port number range. Specify a port range by typing in the first
port number in the range, followed by a colon, then the last number in the port range, with no
spaces between the numbers and the colon.

- eth0, wlan0, or tun0—Select which port this rule applies to by moving the slider to the right so
that it shows green (@l ).
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5. Click OK. If there are any errors in your selections groov Manage highlights the error and displays an error

message.
r test
1 Title test |
Protocol tep
Port 22
Reserved for Opto rules
Add Port Optional

port or port:range

etho (

eth1

wlan0 (
Cancel Delete OK

Deny: eth1

Fix the error or errors and then click OK.
6. Repeat the previous two steps for any additional rules you want to create.
7. Click Save. groov Manage displays a message that it is configuring the firewall.

Please wait while the firewall is configured. This may take
awhile.

OptoMMP
Ports: 2001
Allow: eth0,tun0
Deny: wlan0

After groov Manage finishes saving and implementing the changes, it displays the Security page.

Please note that adding or changing firewall rules (which effectively opens ports in the firewall) does not start
the listening services that may or may not be behind those ports. If you encounter problems accessing those
services, check that the services are on and listening.

Changing a Firewall Rule

When you make changes to groov RIO’s firewall, the changes take effect immediately. So, make sure you
schedule this change during a time that minimizes the impact to your system and users. If necessary, notify
your users of this change so they can plan accordingly.

To change a firewall rule;
1. Loginto your groov RIO with a user ID that has administrator privileges.
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2. C(lick Security > Firewall. The Firewall page displays the rules currently in effect and may look similar to
this:

GroOVMANAGE =

€ Cancel Firewall Save

groov RIO
Ports: 80,443 >
Allow: eth0,wlan0,tund

OptoMMP
Ports: 2001
Allow: eth0,tun0
Deny: wlan0
ModbusTCP
Ports: 8502
Allow: eth0,tun0
Deny: wlan0

3. (lick or tap on the rule you want to change.
4. Make changes.
5. Click OK. If there are any errors in your changes, groov Manage highlights the error and displays an error

message.
test
| Title test |
Protocol tcp
Port 22
Reserved for Opto rules
Add Port Optional

port or port:range

etho (

eth1

wlan0 (
Cancel Delete OK

Deny: eth1

Fix the error or errors and then click OK.
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6. Click Save. groov Manage displays a message that it is configuring the firewall. If there are any conflicts
with existing rules, groov Manage will highlight the row with the conflict and then you can change the
rule to eliminate the conflict.

+* %
:
Q..

Please wait while the firewall is configured. This may take
awhile.

OptoMMP

Ports: 2001 >
Allow: eth0,tun0

Deny: wlan0

After groov Manage finishes saving and implementing the changes, it displays the Security page.

Please note that adding or changing firewall rules (which effectively opens ports in the firewall) does not start
the listening services that may or may not be behind those ports. If you encounter problems accessing those
services, check that the services are on and listening.
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6: Connecting groov RIO to a
Network or Multiple Networks

The topic of networking can be complex. In this chapter, we cover the following scenarios:

Connecting groov RIO to a local area network, either wired or wireless.
Connecting groov RIO to a virtual private network (VPN).

Network configuration changes will require a restart of the network connections on RIO. It's important to have
groov Find ready to help you locate your RIO on the network. If you are not familiar with groov Find,
see”Downloading and Running groov Find” on page 100. Schedule this task at a time that minimizes the
impact on your application and equipment.

If you have an IT department, work with them as you complete these steps:

1.

Review your current networking requirements and practices, as well as groov RIO's networking
capabilities and default settings. Decide whether the default network settings are sufficient for your
network or if you need to change some of the defaults. For more information, see “Reviewing RIO’s
Network Capabilities and Default Settings”on page 34.

If you'll be changing the default network settings or connecting to a virtual private network with
OpenVPN, gather up and verify the information you need before you begin changing settings. See
“Collecting Network Configuration Information”on page 38.

Configure the appropriate network interfaces (ETHO, WLANO) on your groov RIO with the information you
collected from the previous step. See “Configuring the Network Interfaces”on page 42.

If you are connecting to a virtual private network with OpenVPN, configure the OpenVPN Tunnel O
interface as described in “Connecting to a Virtual Private Network (VPN)” on page 44.

Test your network connections and fine-tune your security. See “Testing the Network Connections and
Fine-Tuning Security” on page 46.
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REVIEWING RIO'S NETWORK CAPABILITIES AND DEFAULT SETTINGS

34

You can connect groov RIO to up to three different networks:

«  Wired communications through either ETHO or ETH1.
Note that you can't connect two different networks
through these interfaces; RIO has switched Ethernet USB (WLANO)
interfaces, not independent Ethernet interfaces.

«  Wireless communication, through an approved USB ETHO
WiFi adapter connected to the USB port. For a list of
approved adapters, see “Installing an Approved USB
WiFi Adapter”on page 95.

«  Avirtual private network (VPN), connected through
either ETHO, ETHT, or WLANO.

WLANO is physically separated from ETHO/ETH1, which
means there is no communication or routing between the
wired and wireless networks.

ETH1

You can configure the network interfaces to connect to several networks in a variety of combinations. For

example:
«  Configure ETHO to connect to a local control network and configure WLANO to connect to a local office
network.

«  Configure ETHO to connect to a local network, configure OpenVPN Tunnel 0 to connect to a virtual
private network, and leave WLANO alone or, for enhanced security, disable it.

«  Configure ETHO to connect to your local control network and configure WLANO to connect to the
Internet.

In addition, you can daisy-chain RIOs: connect several RIOs through their wired network interfaces to form a

chain. The primary advantage of daisy-chaining is that you save the expense of network routers or switches.

The primary disadvantage is similar to that of a serial network: if communication with one RIO is lost,

communication to all RIOs beyond it on the daisy-chain are also lost. If you do decide to daisy-chain RIOs, keep

in mind the following:

«  When you update firmware on RIOs in the chain, you must update them one at a time.

«  You cannot daisy-chain RIOs through WLANQO, the wireless network interface.

«  Never form a loop or ring with a chain of RIOs. As a rule, do not connect the second interface on the last
RIO on the chain to any other device.

«  You cannot daisy-chain RIOs powered through PoE. All the RIOs in the chain must be powered with a
10-32V DC power supply.
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The following illustrations show the correct and incorrect way to daisy-chain RIOs:

CORRECT DAISY-CHAIN CONNECTIONS

4 1 1
2 L W& cave the 2nd interface on
the last RIO unconnected.
/ Daisv-cha
Y aisy-chain

/ connections

Connections from a network, SNAP PAC
controller, groov EPIC processor, or PC to a RIO.

P

INCORRECT DAISY-CHAIN CONNECTIONS

Ethernet Switch

C0000000 -

Ethernet Switch

Ethernet Switch

Understanding RIO’s Default Network Configuration

When you take it out of the box, groov RIO is ready to automatically connect to a network by plugging an
Ethernet cable into ETHO or ETH1. This works most directly in a network that is simple (for example, a
computer and a few devices) and that has a DHCP server that manages IP addresses.

If your groov RIO will be running in this type of networking environment, review “Initializing with a Wired

Connection”on page 36.You can probably skip over the rest of the information in this chapter. However, if you

think you might need to change this configuration:

1. Review these two sections to understand two important network operations of groov RIO:
- ‘Initializing with a Wired Connection”on page 36
- "Keeping Networks Separate”on page 36

2. Read through “Reviewing Your Network Requirements”on page 36 (with your IT department, if you have
one) to understand all the important you choices you may have to make so that RIO can your work in
your networking environment.

3. Collect the information you need, based on the choices you made in the previous step. (See “Collecting
Network Configuration Information” on page 38.)

4. Make the changes to RIO (see “Configuring the Network Interfaces”on page 42.)
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Initializing with a Wired Connection

When you initialize your RIO, you must connect it to a network through either ETHO or ETH1, which means a
wired network connection. (For more information about initialization, see Chapter 3: Initializing a groov RIO.)
So, plan on using RIO right out of the box with a wired network connection. After you finish all the
initialization (which can include configuring the network interfaces for other types of network connections),
you'll switch to the networking configuration you want.

If, with your new network configuration, you won't be using some of your network interfaces, you may want
to disable them to prevent unauthorized access to your RIO. However do not disable those network interfaces
until you have verified that your new network configurations works; if you don't test it, you may end up with
a RIO that is inaccessible (including through groov Find) and you will have to reset it to factory defaults.

To disable a network interface:

1. From the groov Manage Home page, click System > Network.

2. (lick Configure.

3. Forthe network interface(s) you aren't using, click IPv4 Method, then select Disabled.
4. Click Save. groov Manage will save the changes and restart the network connections.

Keeping Networks Separate

Each network interface must be connected to a separate network. Make sure that the wireless access point
(SSID) that you select for WiFi is not on the same network as ETHO.

REVIEWING YOUR NETWORK REQUIREMENTS

36

In a simple network, a DHCP server assigns the following to any new device that joins the network:
« [Paddress

«  Subnet mask

«  DNSserver: IP address and domain name

«  Gateway IP address

With simple applications and networks, having the DHCP server manage these assignments is usually
sufficient. Out of the box, groov RIO is designed to work with this type of network. If your application and
network fall into this category, review “Choosing between Automatic and Manual Connections” (below).

However, for certain applications or in some complex networking environments, you may want groov RIO to

override or ignore the information it receives from the DHCP server.

«  Example 1—Your IT department may want to assign your RIO a static IP address and subnet mask.

«  Example 2—Your IT department may want to assign a specific gateway address, or DNS server IP
address and domain name to a network interface (ETHO, WLANO, or OpenVPN Tunnel 0).

«  Example 3—Your IT department may want to route traffic leaving groov RIO through a specific path.

These examples illustrate why it is important to work with your IT department (if you have one) before
connecting your groov RIO to a complex network. Review the information in the rest of this section with your
IT department. As you review the information, you'll be collecting information that you'll need when it's time
to configure the network interfaces. Instructions on what information you need to collect are in “Collecting
Network Configuration Information” on page 38.

Choosing between Automatic and Manual Connections

For each physical network interface on a groov RIO that you are connecting to a network, you can choose one
of two connection methods:
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«  Automatic—The DHCP server assigns the IP address and subnet mask. Select this method if:
- Your network is simple and small with a DHCP server.
- The default network settings on groov RIO meet the needs of your network environment.

- The default network settings meet your networking requirements and you plan to add a wireless
adapter.

—  The DHCP server can assign the IP address and subnet mask, but you want to be able to override the
gateway address or DNS IP address and name server.

For any of these situations, review “Collecting Information for Automatic Connections”on page 38.

«  Manual—You or the IT administrator need to enter an IP address, a subnet mask, and, in the cases
described below, additional configuration information. Select this method if you or your IT department
require advanced network configurations.

Implementing Advanced Networking Requirements

For the unique cases described earlier, review the information below. Most of these options are available on all
the network interfaces (ETHO, WLANO, and OpenVPN Tunnel 0).

«  Ifyou need to override the DNS server IP address and domain name assigned by the DHCP server, see
“Overriding the DNS Server IP Address and Domain Name Assigned by DHCP Server” (below).

« Ifyouneed todo either of the following, see “Adding DNS Servers and Specifying the Order in which DNS
Servers are Queried” (below):

—  Add more DNS server IP addresses and domain names.
- Specify the order in which the DNS servers are added to the DNS resolver’s configuration.

« Ifyou need to do either of the following, see “Adding Gateway IP Address or Overriding the Gateway IP
Address Assigned by the DHCP Server” (below).

- Add a gateway IP address or override the gateway IP address assigned by the DHCP server.

- Alter the order in which gateways are invoked. Gateway Order determines which interface's
gateway is used for off-subnet destination-based routing. The gateway associated with the active
interface with the lowest gateway order will be used as the default gateway. For more information
about this topic, see “G: Advanced Networking Configurations”on page 247.

Overriding the DNS Server IP Address and Domain Name Assigned by DHCP Server. If your
network policy is for the DHCP server to assign the IP address and subnet mask, but the IT administrator
manually assigns the domain name server (DNS), you will need the IP address and domain name of that server
when it's time to configure groov RIO. Record this information “Table of Additional Gateway IP Addresses, DNS
IP Addresses and Name Servers, and Order”on page 40 (in the Automatic section, as DNS Server 1 Override
and DNS Domain 1 Override, under the network interface that requires this configuration) so that it is readily
available when you configure your RIO.

You can specify additional domain name servers, entering them as the second (DNS Server 2 Override with
DNS Domain 2 Override) and third (DNS Server 3 Override with DNS Domain 3 Override) entries in the table,
also in the Automatic section.

Adding DNS Servers and Specifying the Order in which DNS Servers are Queried. You can
assign up to three domain name servers to each network interface on RIO and indicate the order in which to
communicate with the servers. You can set the DNS Order of a network provisioning domain to specify the
priority that name servers and search domains are added to the DNS resolver's configuration, which has a
maximum limit of three name servers and six search domains. When a DNS request is made, the resolver
queries name servers in series in the order defined in the configuration. If a response is received with either a
successful resolution or with a reply code such as "Name not found", no other name servers are queried. If the
DNS request times out, the next name server is tried until all name servers are exhausted. Be aware that name
resolution of secondary and tertiary name servers may be slow due to the sequential nature of queries by the
DNS resolver.
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For each network interface that requires this configuration, make a note of the DNS server IP addresses and
domain names in the Automatic section (for network interfaces where you selected Automatic connection) or
the Manual section (for network interfaces where you selected Manual connection) of “Table of Additional
Gateway IP Addresses, DNS IP Addresses and Name Servers, and Order”. The DNS Order is per network
interface, with 1 being the highest priority (the network interface queried first).

Adding Gateway IP Address or Overriding the Gateway IP Address Assigned by the DHCP
Server. If your network policy requires the assignment of a specific gateway IP address, review the
information in “Redirecting Traffic Initiated by an Incoming Connection Request”on page 247 to understand
how groov RIO manages gateway assignments and prioritizes their use.

For each network interface that requires this configuration, make a note of the gateway IP address in the
Automatic section (for network interfaces where you selected Automatic connection) or the Manual section
(for network interfaces where you selected Manual connection) of “Table of Additional Gateway IP Addresses,
DNS [P Addresses and Name Servers, and Order”. The Gateway Order is per network interface, with 1 being
the highest priority (the network interface queried first).

COLLECTING NETWORK CONFIGURATION INFORMATION

If you will be changing the default network setting or connecting to a virtual private network (VPN), you will
want to collect some configuration information from your IT administrator. To help you organize this
information and make it quicker to do the configuration, print the following tables and fill them out as you
collect the information.

«  "Tables for IP Address, Subnet Mask, and Additional Wireless Settings”on page 39

«  “Table of Additional Gateway IP Addresses, DNS IP Addresses and Name Servers, and Order” on page 40

Save this information in a secure location that you can quickly access and refer to this information when you
start following the instructions in “Configuring the Network Interfaces”on page 42.

Collecting Information for Automatic Connections

By default, groov RIO connects to networks automatically. If this method adequately meets the needs of your

application, then:

«  Forwired communications, there is no additional information that you need to collect. Fill in the table
(“Tables for IP Address, Subnet Mask, and Additional Wireless Settings”) with “Automatic”in the ETHO
column to remind you that you do not need this information.

o For wireless communications, fill in the IP address and Subnet mask rows of the table with “Automatic”;
you don't need to manually specify an IP address and Subnet mask with Automatic. However, you do
need to collect the following information:

- SSID—A text string from 1 to 32 characters that uniquely identifies the wireless network. This
should be the name of the wireless network access point you want groov RIO to join.
—  Encryption—The type of encryption to secure the packets:

- None—Do not encrypt the packets.

- WEP—A wireless security protocol that is not secure and has been deprecated by the Institute
of Electrical and Electronics Engineers (IEEE). Do not select WEP for new installations unless it is
the only option available. Instead, select WPA or WPA2.

- WPA—Encrypt the packets with TKIP encryption (RC4) and an 8 to 63 digit ASClI or 64 digit
hexadecimal key.

- WPA2—Encrypt the packets with CCMP encryption (AES) and an 8 to 63 digit ASClI or 64 digit
hexadecimal key.
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- Key Type—Select one of the following:

- Passphrase (ASCIl)—This is the typical key type for WPA.
- PSK(HEX)—This is the typical key type for WEP.

—  Key—The password groov RIO must provide when it tries to join the wireless network.

TABLES FOR IP ADDRESS, SUBNET MASK, AND ADDITIONAL WIRELESS SETTINGS

WIRELESS
WLANO

IP address IP address

Subnet mask Subnet mask
SSID
Encryplion type | 0wt 0w @ A
e Ry 4
Key Do not write down.

Collecting Information for Manual Connections

If you want to specify network configuration information manually, work with your IT department (if
available), and note the following information in the “Tables for IP Address, Subnet Mask, and Additional
Wireless Settings”on page 39:

IP Address and Subnet Mask—These two pieces of information work together to create a unique
network address. It's very important that you create a unique network address by assigning each network
interface a different IP address and subnet mask. While the IP address must be different than any other
device on the same network, the subnet mask must be the same as all other devices on the same network.
For example:

—  All'the devices on network A are assigned a subnet mask of 255.255.0.0.

—  All the devices on network B are assigned a subnet mask of 255.0.0.0.

If you connect the processor to network A, make sure to specify 255.255.0.0 as the subnet mask.

For wireless communications, in addition to the IP address and subnet mask, you need to collect the
SSID, Encryption, Key Type, and Key, as described “Collecting Information for Automatic Connections’
on page 38.

q

If you are also configuring the network interfaces for the complex scenarios described in “Implementing
Advanced Networking Requirements”on page 37, that section described what information to collect and
where to store in “Table of Additional Gateway IP Addresses, DNS IP Addresses and Name Servers, and Order”
on the next page.
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TABLE OF ADDITIONAL GATEWAY IP ADDRESSES, DNS IP ADDRESSES AND NAME SERVERS, AND
ORDER

Setting ETHO WLANO OpenVPN Tunnel 0
Gateway Override
DNS Server 1 Override
DNS Server 2 Override
DNS Server 3 Override
DNS Domain 1 Override
DNS Domain 2 Override
DNS Domain 3 Override

Automatic

Gateway Order
DNS Order
Gateway Address N/A
DNS Server 1
DNS Server 2
DNS Server 3
DNS Domain 1
DNS Domain 2
DNS Domain 3

Manual

Gateway Order
DNS Order

Collecting Network Configuration Information for OpenVPN Connection

There are many resources available online to help you learn about and set up a virtual private network (VPN)
with OpenVPN technology. This section assumes you have a functioning OpenVPN server. groov RIO works as
an OpenVPN client that connects to the OpenVPN server. (groov RIO cannot be set up as an OpenVPN server.)
You'll need the OpenVPN server administrator to provide you with the following:

«  Ausername and password to login to the OpenVPN server.
+  Ifnecessary, a username and password for proxy connections.

«  Depending on the security and authentication configuration of the OpenVPN server, you may need some

or all of these files or information:

— Apublic key, also known as a certificate, which is typically available as a file thatends in . crt.

- Aprivate key that is created specifically for your groov RIO. It is typically available as a file that ends in
.key.

- ACertificate Authority (CA) certificate and key, which helps verify the public and private keys. These
are also typically provided in files, with the certificate file that ends in . crt and the key file that
endsin . key.

—  An OpenVPN static key, if required. Not all sites implement OpenVPN static keys. This key is typically
stored in afile called static.key.

«  The following server information:
- Protocol-The communications protocol used by the OpenVPN server.

—  OpenVPN server hostname and port number-The hostname is usually a fully-qualified domain
name (for example, vpnserver.example.com) or it could be an IP address.

- Encryption Cipher-The encryption cipher used by the OpenVPN server.
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- LZO Compression-If the OpenVPN server uses LZO compression, then you will need to enable it
on your groov RIO.

Some of this information can be provided in a configuration file, which you can then upload into your
groov RIO. Uploading a configuration file could make configuring the processor easier and you will be less
likely to introduce typing errors. When you receive the configuration file, review it to make sure it has the
following information (and in the format indicated), as appropriate for your OpenVPN server's security and
authentication configuration:

«  Certificate Authority (CA)—The CA section should be surrounded by <ca>and </ ca> tags. Inside those
tags, the certificate text should be surrounded by <cert>and </cert> tags.

«  Private and Public Key—The key text should be surrounded by <key> and </key> tags.
«  Open VPN static key—The key text should be surrounded by <t1s-auth>and </t1ls-auth> tags.

If it doesn't contain this information, you can edit the file and add it, making sure it is surrounded by the tags
described previously.

If the administrator can't provide a configuration file, print the following table to collect the above
information, save it in a secure place, and have it handy when you follow the instructions in “Connecting to a
Virtual Private Network (VPN)"on page 44.

TABLE OF OpenVPN SETTINGS

Information Value

Protocol O udp 4 tcp-client
OpenVPN Server Host Name
OpenVPN Server Port Number

Remote Public Certificate Path
and File Name

User Name

Password Do not write down.

Proxy User Name

Proxy Password Do not write down.
Encryption Cipher O none d
LZO Compress O yes U no
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CONFIGURING THE NETWORK INTERFACES

1.

Log into groov RIO with a user ID that has administrator

privileges.

Click System > Network. groov Manage displays the

Network status page.

The Network status page shows you the current network
configuration, and provides access to the Network
configuration page, as well as diagnostic tools.

In the example to the right, RIO is connected to a
network through a cable plugged into ETHO. There is no
WiFi connection through WLANO, and no connection to
a virtual private network. The values listed in the
Network Options section were assigned by the local

DHCP server.

Click Configure. groov Manage displays the Network
configuration page. The example to the right shows the

default settings.

Ethernet O shows the current settings for ETHO. Wi-Fi

shows the current settings for WLANO.

OpenVPN Tunnel 0 shows the current settings for a

virtual private network.

- To configure ETHO for wired communications, see

“Configuring ETHO" on page 42.

GroOVMANAGE =
€ System Network Configure
Hostname opto-04-80-2a

Ethernet 0
Link Status Connected
MAC Address 00:A0:3D:04:80:2A
IPv4 Method Automatic (DHCP)
IP Address
Subnet Mask
Gateway 1

Wi-Fi
Link Status Disconnected
MAC Address
IPv4 Method Disabled

OpenVPN Tunnel 0
Link Status
MAC Address
IPv4 Method

Disconnected

Disabled
Network Options

DNS Server 1
DNS Server 2

DNS Domain 1
Diagnostics »
GrOOVMANAGE =
< Cancel Network Save

Hostname opto-04-80-2a

Ethernet 0

IPv4 Method Automatic (DHCP)

Gateway Override Optional
DNS Server 1 Override Optional
DNS Domain 1 Override Optional
Gateway Order 1
DNS Order 1

- To configure WLANO for wireless communications,

see “Configuring WLANQ" on page 43.

Wi-Fi

IPv4 Method Disabled

When you are done with all the configurations, go to

“Saving the Configuration”on page 44.

Configuring ETHO

OpenVPN Tunnel 0

IPv4 Method Disabled

You'll want to have the information you collected when you read through “Collecting Network Configuration
Information”on page 38 available as you follow these steps:

1.

From the Network configuration page, click
the IPv4 Method currently assigned (the text
in green) to ETHO. groov Manage displays the
IPv4 Method window (see right).

Click the connection method you want. If
you choose Disable, skip to step 5.

If you selected Automatic and you don't

IPv4 Method

+ Automatic (DHCP)

Manual (Static)

Disabled

Cancel

want to override the DHCP server settings for gateway, DNS address, and DNS name server, skip to step 5.
Otherwise, now is when you enter those override values from “Table of Additional Gateway IP Addresses,
DNS IP Addresses and Name Servers, and Order” on page 40.
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4. Ifyou selected Manual, the Network configuration page

changes to display additional fields. You'll want to refer to Ethernet 0
the values you entered in “Table of Additional Gateway [P 1Pv4 Method Manual (Static)
Addresses, DNS IP Addresses and Name Servers, and 1B Address Mzasaaa
Order” to fill out these fields: Subnat Mask H5200.255.0
Gateway Address Optional
- |P Address DNS Server 1 Optional
- Subnet MaSk DNS Domain 1 Optional
- Gateway Address Gatevay Order i
DNS Order 1

—  DNS Server 1 and DNS Domain 1
These two fields must be specified as a set. If you
need to enter more than one set, groov Manage
displays fields to enter a second and third set after you enter the previous set.

- Gateway Order

—  DNS Order

5. Choose from the following:

- If you need to configure WLANO for wireless communications, go to “Configuring WLANO" on
page 43.

- Ifyou are done configuring the physical network interfaces, go to “Saving the Configuration”on
page 44.

Configuring WLANO

1. From the Network configuration page, click the IPv4 Method in the Wi-Fi section and select the
connection method you want. groov Manage updates the Network configuration page as shown below
(automatic on the left, manual on the right):

DNS Order 2 DNS Order
Wi-Fi Wi-Fi

IPv4 Method Automatic (DHCP) IPv4 Method Manual (Static)
SsID Required SsID Required
Encryption None Encryption None
Gateway Override Optional IP Address 10.20.30.40
DNS Server 1 Override Optional Subnet Mask 255.255.255.0
DNS Domain 1 Override Optional Gateway Address Optional
Gateway Order 3. DNS Server 1 Optional
DNS Order 3 DNS Domain 1 Optional
~ R Gateway Order 3
DNS Order 3

2. Enter the information you collected in “Collecting Network Configuration Information”on page 38.
3. Choose from the following:
- Ifyou need to configure a network interface for wired communication, see “Configuring ETH0" on
page 42.
- Ifyou are done configuring the network interfaces, go to “Saving the Configuration”on page 44.
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SAVING THE CONFIGURATION

In the Network configuration page, click Save. groov Manage displays a message that it will restart the network
connections.

: ik I

I The network is restarting. ‘
In a moment, the application will be reloaded using:
https://opto-03-Fa-bF

If the device is no longer reachable, you may use the device's
screen to make further adjustments.

DNS Domain 1 Override Optional
Gateway Order 1
DNS Order 1
Ethernet 1
IPv4 Method Disabled
Wi-Fi
IPv4 Method Disabled
OpenVPN Tunnel 0
IPv4 Method Disabled

After the network connections are restarted, if groov Manage doesn't reappear and you can't access your RIO
through any of the network connections you configured, start up groov Find to help you locate your RIO (see
“Downloading and Running groov Find"on page 100).

After you reconnect to your RIO, you can test the network connections and fine-tune your security settings. If
you need to set up a virtual private network (VPN), see “Connecting to a Virtual Private Network (VPN)"on
page 44.

CONNECTING TO A VIRTUAL PRIVATE NETWORK (VPN)

Before you begin:

«  Make sure you've configured at least one physical network interface (see “Configuring the Network
Interfaces”on page 42) and that it's functioning.

«  Checkthat you have all the information you collected when you reviewed “Collecting Network
Configuration Information for OpenVPN Connection”on page 40.

«  Verify that the OpenVPN server is reachable.

Let's begin:
1. From a browser, connect to groov RIO and log into groov Manage with a user ID that has administrator
privileges.

2. Ifyou will be entering the configuration manually (without a configuration file as described in “Collecting
Network Configuration Information for OpenVPN Connection”on page 40), upload the public key.

a. From the groov Manage Home page, click Security > Client SSL.
b. Click Add/Update.
c. Navigate to the folder where you stored the public key (. crt) file.
d. Select the key, then click Open.
3. (Click Back > Home to return to the groov Manage Home page, then click System > Network.
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4. (lick Configure.
5. Inthe OpenVPN Tunnel 0 section, click IPv4 Method and select Automatic (DHCP).

IPv4 Method

OpenVPN Tunnel 0

IPv4 Method Automatic (DHCP)

Use Configuration Wizard
Guided input for basic client configuration.

& Upload Client Configuration File

&, Set User Credentials

@, Set Proxy Credentials

>

Current ConFfiguration
Gateway Order 255

DNS Order 255

6. Enter the configuration information you collected when you reviewed “Collecting Network Configuration

Information for OpenVPN Connection” on page 40.
If your VPN information is in a client configuration file, click Upload Configuration File. Navigate to
the folder where you stored the configuration file, select it, then click Open. Click Set User
Credentials to enter the OpenVPN server user name and password. If necessary, click Set Proxy
Credentials to enter the proxy credentials. Go to step 7.

If you need to enter the configuration information manually, slide the User Configuration Wizard

a. (lick Protocol to select the protocol used by your
OpenVPN server.

b. Enter the IP address or full domain name of the
OpenVPN server in the Remote Host field

c. Toenter the port number, click in the space
between the - and + sign. Type in the port
number.

d. Click Select Certificate and select the certificate
you uploaded in step 2 on page 44.

e. Inthe Username and Password fields, type in the
OpenVPN server username and password. (Not
the proxy username and password.)

f.  Click Encryption Cipher and select the cipher
used by your OpenVPN server from the list.

g. [Ifthe OpenVPN server users LZO compression,
slide the LZO Compress switch to the right, until it
turns green.

h.

switch to the right, until it turns green.

OpenVPN Tunnel 0
1Pv4 Method Automatic (DHCP)
Use Configuration Wizard (
Guided input for basic client configuration.
Protocol udp
Remote Host Required
Remote Port [S) @

Remote Public Cert Select Certificate
Select the certificate authority PEM certificate. You can upload the CA
certificate from Manage -» Security -» Client SSL.

Username Reguired
Password Required
Encryption Cipher None
LZO Compress

Gateway Order 255
DNS Order 255

If you need to modify the Gateway and DNS order, click on those numbers and change them.

7. Click Save. If groov Manage reports any errors, fix those errors and click Save. Otherwise, groov Manage
displays a message that it will restart the network connections.
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I % I

The network is restarting.
In a moment, the application will be reloaded using:
https://opto-03-Fa-bF

If the device is no longer reachable, you may use the device's
screen to make further adjustments.

DNS Domain 1 Override Optional
Gateway Order 1
DNS Order 1
Ethernet 1
IPv4 Method Disabled
Wi-Fi
IPv4 Method Disabled
OpenVPN Tunnel 0
IPv4 Method Disabled

TESTING THE NETWORK CONNECTIONS AND FINE-TUNING SECURITY

To test the network connections, do one of the following:

«  Ifyou switched to Automatic, wait a few seconds for RIO to receive an IP address from the DHCP server.
The logon page will refresh and display the IP address after it receives it.

«  Ifyou switched to Manual, verify that the IP address works by trying to connect to RIO from a web
browser. Or, from a Windows computer that’s connected to the same network, you can try the ping
command in a command prompt window.

If you encounter any issues with ETHO, and WLANQO, see “Troubleshooting” on page 99 for topics regarding
network connections. If you are troubleshooting issues with an OpenVPN connection, you can review the VPN
client logs for messages. To access the logs, from the groov Manage home page, click Info and Help > Logs >
OpenVPN Client.

For enhanced security, disable any network interfaces you aren't using.

You may also want to update your security options and firewall settings:
«  "Managing the SSL Security Features of your groov RIO”on page 24
«  “Configuring the Firewall” on page 27
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A user with administrator privileges is the only user that can change system features. System features provide
services like access control, device management, and time management.

SETTING AND ADJUSTING DATE, TIME, AND TIME ZONES

Setting and adjusting the date, time, and time zones can help you with more than just setting groov RIO to the

local time:

«  You can change the date and time of your groov RIO to test time-sensitive features of your control
program.

»  You can synchronize the clock on your groov RIO to any number of time servers from around the world.

«  You can specify multiple time servers to function as backups of each other, or specify a device as a time
server.

When you turn on your groov RIO for the first time and after it establishes network connectivity, it sets the time
from a default time server. To see the default time server, from the groov Manage Home page, click System >
Time. The bottom half of the screen lists the time servers.

GrOOVMANAGE =
£ System Time Settings
Time Set Time
Year © 2020 @
Month O] 2 ®
Day S 20 @
Hour @ 0 @
Minute © 20 @
Second C] 6 @
All currently signed-in users may be signed out after setting the time.
Time Zone Set Zone
Region Universal
Locality
Time Servers Set NTP
Enable NTP [ @
Time Server 1 0.pool.ntp.org
Time Server 2 1.pool.ntp.org
Time Server3 2.pool.ntp.org

sync your clock with servers on the internet such as 0.pool.ntp.org.
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Setting the Date and Time Manually

There might be a few reasons why you want to set the date and time manually instead of synchronizing to
time servers:

«  Youwant to test time-sensitive features in your control program, so you want to be able to adjust the
date and time to test those features.

«  You are working in an environment (for example, a disconnected test environment) where changes in
time will not affect production or other critical applications.

Note: Changing the time manually will log out any users that are currently logged onto your groov RIO. Carefully
choose when you will change the time to minimize any adverse effect on other users.

To set the date and time manually:
1. Loginto groov RIO with a user ID that has administrator authority.
2. Click System (CEZZNEEN ). then Time (CRESNEEEN )-

3. IntheTime Servers section, turn off the Enable NTP setting by moving the slider to the left so that it
shows grey ( ).

Click Set NTP.
In the Time section, select values for Year, Month, Day, Hour, Minute, and Second.

6. Click Set Time. groov Manage displays a message while it's setting the date and time. When it finishes, the
message disappears.

v oe

Now your date and time are set.

IMPORTANT: Ifyou set the date and time manually, the time will not update for Daylight Savings Time (for those
areas that observe Daylight Savings Time). So, you must remember to manually update the date and time during
those events.

Setting the Date, Time, and Time Zone by Synchronizing with Time Servers

If you are not familiar with time servers, you can learn more about them through the NTP Pool Project at
www.pool.ntp.org. When you are selecting a time server, remember the following:

« ltisagood idea to select a couple of time servers to serve as backups in case groov RIO cannot establish
a connection to the primary time server or if that time server becomes unavailable. The steps below
instruct you to set two additional time servers.

« Ifyou had set your date and time manually, setting the date and time as described in this section will
overwrite your manual settings.

Note: Changing the time manually will log out any users that are currently signed into your groov RIO. Carefully
choose when you will change the time to minimize any adverse affect on other users.

To select the primary time server and a few backups:

Log into groov RIO with a user ID that has administrator privileges.

Click System (CEEZS ). then Time (EEE D ).

In the Time Servers section, click Time Server 1. Enter the host name of the time server.
Click Time Server 2. Enter the host name of a second time server.

Click Time Server 3. Enter the host name of a third time server.

Click Set NTP. groov Manage displays a message while it's synchronizing with the time servers. When it
finishes, the message disappears.

SOk whN=

Now your date and time are set, as well as the time zone. The date and time will be updated automatically
during the switches between Standard Time and Daylight Savings Time, according to the schedule set by the
time servers.
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Setting the Time and Time Zone by Selecting a Location

If you want to set the time by selecting your location, do the following steps:

1. Loginto groov RIO with a user ID that has administrator privileges.

2. Click System (CEEZNN ). then Time (R )-

3. IntheTime Zone section, click Region to select a general geographical area of the world.

To set the time for cities or regions in the United States of America, select America as the region. America
encompasses North, Central, and South America.

4. C(lick Locality to select a specific city that most closely approximates the city within the time zone you
want to set.

5. Click Set Zone. groov Manage displays a message while it's setting the time. When it finishes, the
message disappears.

MANAGING THE USB PORT

groov RIO can work with any of the following devices inserted into the USB port:

«  USB storage devices. Certain requirements must be met, as described in “Requirements for USB Storage
Devices"on page 51.

«  USB-to-serial adapters. Only certain adapters are supported. You can find a list at “Connecting Serial
Devices”on page 49.

«  WiFiadapters. Only certain adapters are supported. For a list, see “Installing an Approved USB WiFi
Adapter”on page 55.

If you do not plan on attaching any USB devices, it would be a good security practice to leave the USB port
disabled. Disabling the USB port prevents any unauthorized access to RIO through the port. By default, the
port is disabled, so if you plan on attaching any of the devices listed above, you need to enable the USB port.:

1. Loginto groov RIO with a user ID that has administrator privileges.
2. Click System > USB.

GrCOVMANAGE =

€ System use Save

Enable USB

You can disable USB for security purposes. If you re-enable USB
reconnect your devices.

Automount

Automatically mount FAT and FAT32 Formatted USB storage drives to the
files page.

USB Files »

3. (lick the Enable USB slider so that it turns green.
Click Save. groov Manage returns you to the System page. Now you can:
- Attach a USB storage device (see “Attaching and Detaching a USB Storage Device”on page 51).
—  Connect a serial device(s) (see “Connecting Serial Devices” on page 49).
- Attach a WiFi adapter (see “Installing an Approved USB WiFi Adapter”on page 55).

CONNECTING SERIAL DEVICES

You can connect serial devices to groov RIO by inserting a USB-to-serial adapter into the USB port. Before you
attach the adapter, make sure you enabled USB as described in “Managing The USB Port” on page 49.

Note: Only Node-RED flows can access serial devices connected through a USB-to-serial adapter.
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The following table lists USB-to-serial adapters supported by groov RIO.

Device
Model

Manufacturer

USOPTLA4 (isolated RS-485)
B&B Electronics USPTL4 (non-isolated RS-485)
USO9ML2 (isolated RS-232)

GM-482422 (non-isolated RS-485/RS-422)
Gearmo GM-FTD1-A12 (non-isolated RS-232)
SERIAL-B (non-isolated RS-232)

You can expand the number of serial devices you can connect to groov RIO by installing a USB hub to the USB
port. When you do this, it's important to keep track of the device names and port numbers that groov RIO
assigns to the USB-to-serial adapter that you plug into each USB port on the hub (see “Understanding How
groov RIO Assigns Port Numbers and Device Names When Using a Hub”on page 50). One way to do this is:

1. Go to the Serial Devices page in groov Manage (Home > System > Serial Devices).
2. Insertan adapter into a port. groov Manage will detect the adapter, assign it a device name and port
number, then refresh the page to show the information.

3. Make note of the device name and port number so that you have it handy as you develop Node-RED
flows.

If you move a serial device from one USB port of the USB hub to another port on the hub, groov RIO assigns it
a new port number, and possibly a new device name. These changes might require changes to your
Node-RED flows.

Before you start connecting an adapter of USB hub to your RIO, see “Managing The USB Port”on page 49.

Device Name and Port Number

groov RIO assigns /dev/ttySer0 as the device name and 0 as the port number to the USB-to-serial adapter you
plug into the USB port. You use the device name and port number in your Node-RED flow to access the serial
device.

Understanding How groov RIO Assigns Port Numbers and Device Names When Using a Hub

If you connect a USB hub to the USB port, groov RIO includes a suffix to the device name and port number to
identify the port number on the USB hub. For example, if you connect a 4-port USB hub to the USB port, then
groov RIO assigns device names and port numbers as follows:

If a USB-to-serial adapter is plugged into port x of groov RIO assigns ita and a port

the USB hub... device name of... number of...
1 /devi/ttySer0.1 0.1
2 /dev/ttySer0.2 0.2
3 /devi/ttySer0.3 0.3
4 /dev/ttySer0.4 0.4

IMPORTANT: If you move the adapter from one USB port on the USB hub to another USB port, groov RIO will
assign a new port number and device name to the adapter. Any Node-RED flow that references the old port number
and device name will need to be modified to refer to the new port number and device name.

Finding Device Names and Port Numbers

You can find device names and port numbers through groov Manage.
1. Log into your groov RIO with a user ID that has administrator privileges.
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2. (lick the menu button (E), then click System.

3. Click Serial Devices. The Serial Devices page shows the device names and port numbers for any
USB-to-serial adapter plugged into the USB port.

ATTACHING AND DETACHING A USB STORAGE DEVICE

You can attach a USB storage device to the USB port on groov RIO, then use groov Manage to copy files to and
from its internal storage. Adding a USB storage device can also increase the amount of storage available for file
activities like data logging.

Important: You should store any critical files in the unit's internal storage. Internal storage utilizes a power-fail safe
file system that prevents data, file and file system corruption in the event that power is removed. USB storage devices
do not utilize a power-fail safe file system.

Requirements for USB Storage Devices

groov RIO supports reading and writing to USB storage devices formatted in either FAT or FAT32 file systems.
This means that groov RIO can not access partitions larger than 32 GB. If you want to read and write to a USB
storage device that is larger than 32 GB, you must format (with a computer) that USB storage device with
multiple FAT32 partitions. groov RIO will be able to read and write to all of the partitions on a properly
formatted USB storage device.

Understanding How groov RIO Handles USB Storage Devices

In addition to the disabling the USB port (see “Managing The USB Port” on page 49), groov RIO provides another
setting that helps manage security issues when dealing with USB storage devices: Automount. When this
setting and Enable USB are enabled, when you attach a USB storage device, groov Manage has immediate
access to its content. If you disable Automount (but leave Enable USB enabled), you will have to go through
some extra steps to give groov Manage access to the content of a storage device.

Reviewing Security Issues with USB Storage Devices

If you do attach a USB storage device, keep the following points in mind:

«  Because there is no mechanism to physically secure (or lock) the USB storage device to groov RIO, it can
be removed by anyone that has access to the unit. It's important to apply important security practices,
like keeping the unit secured under lock and key and providing the key to only trusted individuals.

«  To prevent someone from inserting an unauthorized USB storage device that could contain malicious
software, the Enable USB setting is disabled by default. Carefully consider the security risks before
enabling this setting for an extended period of time.

Disabling Access to USB Storage Devices

If you do not plan on using USB storage devices, it would be a good security practice to disable the ability to
access USB storage devices. You can still use the USB port for other devices, like supported USB-to-serial
adapters or WiFi adapters.

1. Loginto your groov RIO with a user ID that has administrator privileges.

2. From the groov Manage Home page, click System > USB.

3. Ifyou have a USB storage device plugged into groov RIO, unmount it.
a. Click USB Files.

groov RIO User's Guide 51



ATTACHING AND DETACHING A USB STORAGE DEVICE

b. Click Safely Remove. groov Manage displays the following message; click OK to continue:

Reconnecting the drive later requires physical access. Are you sure?

OK | Cancel

¢.  When groov Manage successfully unmounts the storage device, it displays the following message.
Click Close to continue.

Safely Remove Drive

+ Unmount

USB Drives

No USB drives are currently mounted.

4. C(lick the Automount slider so that it turns gray ( ).
5. Click Save. groov Manage displays the System page.

groov Manage no longer has automatic access to the contents of a USB storage device inserted into the
USB port. However, as long as Enable USB is enabled, it can work with USB-to-serial adapters and WiFi
adapters.

Attaching a USB Storage Device

Before you attach a USB storage device, makes you understand:
«  "Requirements for USB Storage Devices”on page 51
«  “Reviewing Security Issues with USB Storage Devices”on page 51

Also, make sure you have Enable USB (see”Managing The USB Port” on page 49) and Automount (see
“Understanding How groov RIO Handles USB Storage Devices”on page 51) enabled.
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Insert the USB storage device into the USB port. To verify that groov Manage has access to the USB storage
device, from the groov Manage Home page, click System > Files. groov Manage displays the Files page.
groov Manage lists the USB storage device in a section called USB Drive, typically followed by a number:

groov =
Files Done
Internal Drive
Secured Files >
USB Drive 1
Label Generic Flash_Disk
Partition 1
Label: USB DISK. >

Path: /run/media/sdat

Safely Remove

USB drives with FAT and FAT32 partitions are supported, which are
commonly used in USB storage devices up to 32 GB.

Devices larger than 32 GB are commonly Formatted with a single exFAT
partition, which is not supported. To use such a device, reformat iton a
computer with multiple FAT32 partitions.

You can now copy, move, and download files (see “Copying, Moving, or Downloading a File on a USB Storage
Device"on page 54).

Detaching a USB Storage Device

Before you detach a USB storage device, evaluate the consequences; for example, would it cause an
interruption to your data logging process? After evaluating the consequences and taking measures to
mitigate those consequences, unmount the device and then remove it.
1. Loginto your groov RIO with a user ID that has administrator privileges.
2. From the groov Manage Home page, click System > USB, then USB Files.
3. Click Safely Remove.
If groov Manage detects that a file on the USB storage device is still being used by a service, it will not
proceed. One likely service that might be using the storage device is a Node-RED flow that is logging
data to the storage device. Check any services that might be using the storage device.
Otherwise, groov Manage displays the following message, which reminds you that if you want to
reconnect the storage device in the future, you will have to physically reinsert it. Click OK to continue:

Reconnecting the drive later requires physical access. Are you sure?

OK | Cancel
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When groov Manage successfully unmounts the storage device, it displays the following message. Click
Close to continue.

Safely Remove Drive

+ Unmount

USB Drives

No USB drives are currently mounted.

4. C(lick Done in the Files page.
5. Physically remove the USB storage device from the USB port.
6. Verify that the device no longer shows up in groov Manage.

If you do not plan on attaching USB storage devices for an extended amount of time, disable Automount to
prevent groov Manage from automatically accessing content on any storage device inserted into the USB port
(see “Reviewing Security Issues with USB Storage Devices”on page 51).

Copying, Moving, or Downloading a File on a USB Storage Device

Before you begin, make sure you have properly mounted the USB storage device as described in “Attaching a
USB Storage Device” on page 52.

«  Copy and move means to transfer a file from the USB storage device to groov RIO's internal storage.
«  Download means to transfer a file from the USB storage device to you computer or mobile device.

These instructions describe how to copy, move, or download one file at a time.
1. Loginto your groov RIO with a user ID that has administrator privileges.
2. From the groov Manage Home page, click System > USB, then USB Files.

3. Clickon Partition 1, or, if you have multiple partitions on the USB storage device, scroll to the correct
partition and click the partition name.

In the Dir Listing section, navigate to the folder that has the file you want to copy, move, or download.
5. Click on the file name. groov Manage displays a list of all the actions you can take on the file:

groovVMANAGE =
Files Done
£ Back File

Name File.txt
Path Jrun/media/sda1/Filet.txt
Size 0B
0 bytes

Last Modified 12/18/2019

1:26:06 P
& Open
& Download
€1 Copy

2 Move

o Delete

- Tocopy afile to RIO's internal storage, click Copy.
- Tomove afile to RIO's internal storage, click Move.
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- Todownload a file to the computer or mobile device, click Download.
6. Click Back (top left).
- Ifyou need to copy, move, or download another file, repeat step 4 and 5.

- Ifyou are done copying, moving, or downloading files, click Done (top right corner). groov Manage
returns you to the USB page.

INSTALLING AN APPROVED USB WIFI ADAPTER

If you want to connect your groov RIO to a wireless network, Opto 22 recommends that you purchase and
install one of the following USB WiFi adapters, which Opto 22 has tested and verified works with groov RIO.
Unverified WiFi adapters should not be used.

Device Manufacturer Model

Linksys AE6000
TP-Link Archer T1U
Sabrent AC600

Collect the following information before starting:
«  SSID of the wireless network.
»  Encryption method required to access the wireless network.

If you are manually assigning an IP address, make sure you also have the IP address and subnet mask you want
to assign to the unit.

Also, make sure you have enabled the USB port (see “Managing The USB Port”on page 49).
1. Loginto your groov RIO with a user ID that has administrator privileges.
2. Insert the WiFi adapter into the USB connector on the bottom of the unit.

Note: If you have a USB storage device inserted into the port, make sure you remove it according to the
instructions in “Detaching a USB Storage Device” on page 53.

Bottom View

USB port

3. Ingroov Manage, go to the Network page (Home > System > Network). If the Wi-Fi section of the
Network page now has a MAC Address, then groov RIO is communicating with the WiFi adapter.
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No WiFi adapter inserted; no MAC address

Subnet Mask

Gateway 1

WiFi adapter installed; MAC address available

Subnet Mask
Gateway 1

Wi-Fi Wi-Fi
Link Status Disconnected Link Status Connected
MAC Address MAC Address 30:23.03:D9:22:FD
IPv4 Method Disabled IPv4 Method Disabled
OpenVPN Tunnel 0 OpenVPN Tunnel 0
Link Status Disconnec ted Link St Di:

Note, however, WiFi is disabled. The next step is to enable WiFi.

Click Configure (top right corner of the Network page).

In the Wi-Fi section, click Disabled.

In the IPv4 Method window, click the connection method you want: Automatic (DHCP) or Manual.
Enter the information you collected.

Click Save. Read the message that groov Manage displays and click OK. After groov Manage verifies the
information and saves the configuration, it displays the network page.

© N wu s

Subnet Mask
Gateway 1

Wi-Fi
Link Status Connected
ssiD doc
MAC Address 30:23:03:D9:22:FD
1Pv4 Method Automatic (DHCP)

IP Address

Subnet Mask

Gateway 2
OpenVPN Tunnel 0

groov RIO is now connected to your wireless network.

ENABLING Node-RED

Node-RED is an open-source, multi-platform software program, where you connect (wire) together devices,
databases, cloud applications, and APIs (application programming interfaces) to create simple logic flows to
accomplish specific goals. It is pre-installed on your groov RIO; you do not have to download and install it on a
computer or embedded device. You just have to enable it, then start creating Node-RED flows. This tight
integration also means that some RIO functions, like backup, apply to your Node-RED projects.

By default, Node-RED is disabled. To enable it:

1. Loginto your groov RIO with a user ID that has system administrator privileges.

2. Inthe groov Manage Home page, click Node-RED.

3. ClickEnable. After the Status field says Running, wait a few seconds before opening the Node-RED Editor.

UPLOADING FILES TO RIO’S INTERNAL FILE SYSTEM OR USB STORAGE DEVICE

56

groov RIO identifies files that you upload as “user files”. You can store files in:

«  The"secured area” of the internal file system, where only services with authentication (for example, a user
name and password, or an APl key) over a secure protocol (HTTPS) can access the files.

«  AUSB storage device attached to the USB port of your RIO. Before you attach a USB storage device to the
USB port, review “Managing The USB Port” on page 49 to make sure groov Manage can access the
storage device.

Note that when you backup your system:
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«  Only the first 10 MB of files that you uploaded are included in the backup file.

«  Thefiles stored on the USB storage device are not included in the backup file.

When groov Manage performs a backup, it lists all the files it included into the backup file in the groov Manage
log file. You can check the log file to determine which other files you need backup by other means. (See
“Backing up Your groov RIO Settings”on page 91.)

1. Loginto your groov RIO with a user ID that has administrator privileges.

2. (lick System > Files. groov Manage displays the Files page.

GrCOVMANAGE =

Files Done

Internal Drive

Secured Files >

USB Drives
Mo USB drives are currently mounted.
The "Automount” option must be enabled on the USB settings page for
USB drives to be usable.
USB drives with FAT and FAT32 partitions are supported, which are
commonly used in USB storage devices up to 32 GB.

Devices larger than 32 GB are commonly Formatted with a single
exFAT partition, which is not supported. To use such a device,
reformat it on a computer with multiple FAT32 partitions.

If you had correctly mounted a USB storage device, it would appear in the USB Drives section, like this:

groOVMANAGE =

Files Done

Internal Drive

Secured Files >
USB Drive 1

Label Generic Flash_Disk

Partition 1

Label: USB DISK >

Path: /run/media/sdal
Safely Remove

USB drives with FAT and FAT32 partitions are supported, which are
commonly used in USB storage devices up to 32 GB.

Devices larger than 32 GB are commenly formatted with a single exFAT
partition, which is not supported. To use such a device, reformat it on a
computer with multiple FAT32 partitions.

3. Upload afile.

To the internal file system, click Secured Files > Upload File.

To the USB storage device, click the name of the partition where you want to store the file, then click

Upload File.

a. Navigate to the folder that contains the file you want to upload and select that file.

b. Click Open. groov Manage uploads the file and then refreshes the Dir Listing section to list the file
you just uploaded.

c. Ifyou need to upload another file, click Upload File and repeats steps a and b. For USB storage
devices, if you need to upload another file to another partition, click Back, select the other partition,
click Upload File and then repeats steps a and b.

When you are done uploading files, click Done.
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SELECTING FUNCTIONS, SIGNALS, AND FEATURES

Before you can configure your I/0, you need to know which channel is going to serve which function and
signal, plus select which features (if available) you need:

Function: Input or output.

Signal: Analog or discrete.

Feature: On State, Off State, Linearization, etc. for those signals that offer features. (For a complete list of
features, see Appendix A: Specifications.)

Note that for CODESYS applications, only a limited set of features are available. The instructions will indicate
which features are available for CODESYS applications.

If you have not determined this yet, here are a couple of options to help you select the right combination:

RIO Explorer— An Opto 22 web app that can help you select a combination of functions, signal types,
and features, and make sure you select channels that can support your choices. When you finish with the
RIO Explorer, you can save a wiring diagram, which will come in handy when it's time to wire up your
devices. Another way to you can use the wiring diagram is to annotate it with specification information
like ranges and scaling for analog inputs, or feature selections for discrete inputs. To learn how to use the
RIO Explorer, see Appendix C: groov RIO Explorer.

Reviewing spec tables, feature tables, and wiring diagrams—~Review the information in Appendix

A: Specifications and Appendix B: Wiring Diagrams as you follow these steps:

a. Review the features table to select which function, signal type, and, if applicable, which feature you
want for each channel. If you are working with CODESYS Development System, check the table on
page 68 for the list of features supported in that environment. You might find it helpful to note your
selections in a table like the one on the following page:
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Channel 0
Channel 1
Channel 2
Channel 3
Channel 4
Channel 5
Channel 6
Channel 7
Channel 8
Channel 9

Function Signal Type Feature Default Values or Specific Settings

(Input or Output) (Analog or Discrete) (if applicable) (if applicable)

b. Foreach channel, check the corresponding section of the specification table and verify that you've
correctly selected everything. For example, if you selected a discrete input with a counter feature for
channel 0, go to the “Discrete Counter Input”section of the chart and verify that channel 0 is within
the range listed for “Available Channels” Also check that the signal that is coming in (for inputs) or
leaving (for outputs) meets the specifications listed.

c. Review the wiring diagrams and check for any additional requirements; for example, any fusing
requirements. It may be helpful to print relevant wiring diagrams and annotate them with
information you collected in the previous two steps or additional information you may need when
it's time to wire your field devices.

Taking the time to check your selections will make it less likely that you'll run into trouble later on, and save
you time.

SELECTING A METHOD FOR CONFIGURING 1/0

There are several ways to configure I/0. For whichever way you select, you'll want to have the information you
collected in “Selecting Functions, Signals, and Features”on page 59 handy. This information can speed up the
configuration process.

«  groov Manage: If you are using your RIO unit as an edge node, where you'll just be transmitting tags to a
cloud service through MQTT or through Node-RED flows, you'll want to configure your I/0 through
groov Manage (see “Configuring I/0 Through groov Manage” below).

«  PAC Control: If you are adding your RIO as an I/0 unit to a PAC Control strategy, you'll want to follow the
instructions in the PAC Control User's Guide (form 1700) instead of the instructions in this chapter.

«  CODESYS Development System: If you are adding your RIO as a remote I/O unit to a CODESYS application,
you'll want to follow the directions in “Configuring I/0 Through CODESYS Development System”on
page 63.

«  OptoMMP: You'll want to review the OptoMMP Protocol Guide (form 1465) to learn the memory map
locations used for I/O configuration.

Note: You cannot use these methods in combination. Any configuration you make through one method can
overwrite configurations made through another method.

CONFIGURING 1/0 THROUGH groov MANAGE
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1. Loginto your groov RIO with a user ID that has administrator privileges.
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2. From the groov Manage Home page, click I/O Channels. The I/O Channels page displays a quick summary
of any channel configurations. If you are configuring channels for the first time, the page looks like this:

GrCOVMANAGE =

< Home 1/O Channels

0 <noname:> >
DI OFF

1 <noname> >
OFF

2 <noname > >
OFF

3 <noname:> >
OFF

4 <noname> >
OFF

5 <noname > >
OFF

6 <noname:>
OFF

7 <noname:> >
OFF

8 <noname> >
OFF

Qo
8w O~ Ua | Zr Qw@n O
v

9 <noname:> >
DO OFF

3. With each channel, do the following:
a. C(lickachannel.
b. Click Configure.

c. Assign a Name to help you quickly and uniquely identify this channel and to help you differentiate it
from other channels that might be configured similarly. This is optional.

d. dlick Channel Type and select a value. Review the information you collected for that channel to
select the correct one.
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Depending on the channel type you select, groov Manage may change the content of channel
page. The following images show a few examples of how the page changes depending on the
channel type you select:

GroOVMANAGE = groOVMANAGE =
€ Cancel Channel 6 Save € Cancel Channel 6 Save
Name Optional Name Optional
Module Type GRV-R7-MM1001-10 Module Type GRV-R7-MM1001-10
Channel Type ICTD Temperature Probe Channel Type Switch Input, Powered Simple Digital Input

Quality Indication ( Quality Indication (
Scaling Public Access
Upper Full 302 °F State (Read)
Lower Full 454 °F When a public access attribute is set, the lv\QTTlservice will be advised of
which channels and features are available to scan
Upper Scaled 302
Lower Scaled -454
Unit Degrees F g,"mVMANAGE —
calibration € Cancel Channel 6 Save
Offset 0 Name Optional
Limited to % 13.5 Degrees F
Module Type GRV-R7-MM1001-10
Gain 0
Between 0.9 and 1.1 Channel Type 5-30 VDC Digital Output
Two-Point Calibration » Quality Indication (
Filtering Watchdog
Filter Weight 0 Enabled
Simple Moving Average 0 value False

1 to 32 Readings; 0 For default
K Sets the channel to the given value when the watchdog timer expires.

Public Access Public Access
Value (Read)

When a public access attribute is set, the MQTT service will be advised of
which channels and Features are available to scan.

State (Read)

When a public access attribute is set, the MQTT service will be advised of
which channels and features are available to scan.

e. Ifyou are transmitting values through MQTT, you want to enable the Value (Read) switch in the
Public Access section. When you do, groov Manage displays another set of switches to help you
identify the specific values you want available to send, as well as whether to make them writable.

Sets the channel to the given value when the watchdog timer expires.
Public Access
Value (Read) (

Deadband 0.0
Value change threshold for an MQTT/Sparkplug publication

Public Access
State (Read) (
On-Latch (Read)

Maximum (Read) OFf-Latch (Read)

Minimum (Read) Counter (Read)
Quality (Read) Writable

Toggle the writable attribute for state, on-latch, off-latch, and counter,
Writable When a public access attribute is set, the MQTT service will be advised|of
Toggle the writable attribute for value, maximum, minimum, and which channels and features are available to scan.
quality.

When a public access attribute is set, the MQTT servide will be advised of
which channels and Features are available]to scan.

Switch Input, Powered Simple Digital Input

ICTD Temperature Probe 5-30 VDC Digital Output

Public Access
State (Read) (
On-Latch (Read)
Off-Latch (Read)
Counter (Read)

Writable
Toggle the writable attribute for state, on-latch, off-latch, and counter.

When a public access attribute is set, the MQTT service will be advised of
which channels and features are available to scan.
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f.  Review the rest of the fields on the channel page and make changes based on the needs of your
application. For example, you may want to set a Watchdog timer on a channel or set the scaling
values for a temperature probe.

g. Click Save. groov Manage displays the channel page with information based on your selected
channel type. For the same examples shows in step d, this is what the channel page may look like:

GrOOVMANAGE = GrOOVMANAGE =
£ Channels Channel 6 Configure € Channels Channel 6 Configure
Name Name
Module Type GRV-R7-MM1001-10 Module Type GRV-R7-MM1001-10
Channel Type ICTD Temperature Probe Channel Type 5-30 VDC
Analog Input Digital Output
Value Invalid Value State m Toggle
Unit: Degrees C
Minimum -261.02 Quality Normal
Maximum -261.02 Fast Updates
) Updates this view very quickly, but may affect system performance.
Quality Error Code #6
Reporting out-of-range designator - below operating limits. g-.l'”“'lMANAGE =
<€ Channels Channel 6 Configure
Fast Updates Name
Updates this view very quickly, but may affect system performance.
Module Type GRV-R7-MM1001-10

Note that the above image shows channel 6
configured to sense from an ICTD temperature
probe. However, an actual probe has not been
wired to channel 6 on this RIO, which means that

Switch Input, Powered
Simple Digital Input.

Srate m

Quality

Channel Type

RIO is sensing values that are out of range from
this configuration. RIO reports this as a quality

error. Fast Updates

Updates this view very quickly, but may affect system performance.

When you are done configuring all your channels, groov Manage displays your selections on the I/0 Channels
page.

If you haven't already done so, wire your field devices to your RIO as described in “Connecting Field Devices”
onpage 11.

CONFIGURING 1/0 THROUGH CODESYS DEVELOPMENT SYSTEM

After you add the Opto 22 Library Package for CODESYS Development System, you can add groov RIO (and
groov EPIC) devices to your CODESYS projects. In CODESYS, a groov RIO is an Ethernet device, and each
channelis a device you “plug”into that Ethernet device. To select the signal types and features for each
channel, you configure the parameters of the device you “plugged in”. To differentiate between the groov RIO
“device”and the channel “device’, we will include “(groov RIO)" or “(channel)” after each reference to “device’,
as necessary. You may also want to read the note below for more clarification on terminology differences.

Here's what you need to do to configure I/0 through CODESYS Development System:

1. Verify that you have the correct version of the Opto 22 Library Package, CODESYS Development System,
and groov RIO firmware. For guidance on what to check, see “Checking Compatibility Between Library
Package, Development System, and Firmware”on page 64.

2. Add the RIO to your CODESYS project.
3. Add channels by “plugging in" devices.
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4. Select the signal types and configure the features for each channel by editing the “plugged in" device’s
parameters.

Note: Throughout this section, instructions may use CODESYS terminology that differs from standard Opto 22
terminology. For example:

In the CODESYS Development System interface, the term “device” refers to many different objects: a
controller, an Ethernet adapter, a field device, or an I/O module. In this guide, “device” typically refers
to a field device (a valve, a pump, a quadrature encoder, etc.). When you read sections of the quide
that do not discuss CODESYS, you can interpret references to “device” to mean the latter definition.

In CODESYS terminology, a groov EPIC processor, a groov RIO, and channels on a groov RIO are
referred to as devices, throughout other sections of this guide, a groov EPIC processor is referred to as
a processor, a groov RIO is referred to as a RIO module, and a channel is referred to as a channel.

- Anapplication, in CODESYS terminology, is roughly equivalent to a PAC control strategy in Opto 22
terminology.

Checking Compatibility Between Library Package, Development System, and
Firmware

The CODESYS Development System offers a rich and broad range of support for devices. As with any robust
development system, it's important to keep up-to-date with releases and review the features, enhancements,
and fixes included in each release, as well as diligently check for compatibility with related software and
firmware. In the CODESYS development environment, it's important to check compatibility between three
main pieces:

«  Opto 22 Library Package for CODESYS Development System. The package contains information for
CODESYS Development System so that it can configure groov EPIC processors, groov 1/0 modules, and
groov RIO modules. Opto 22 updates the package each time a new module is introduced, as well as to
deliver, and bug fixes. You want to review the readme to learn:

-~ Which version of the package delivered support for the groov I/0 or RIO module you want to use in
your application.

- The features, enhancements, or bug fixes delivered in each version of the package.

—  The pre-or co-requisites (for example, a new version of firmware for a groov I/0 or RIO module) that
might be required by one of these features, enhancements, or bug fixes.

- Whether the package requires an updated version of the CODESYS Development System.

You should periodically check the Opto 22 website for updates to the package. For instructions on
installing the latest version of the package into CODESYS Development System, see “Updating Device
Information with the Latest Version of Opto 22 Library Package” on page 64.

«  CODESYS Development System. The Development System periodically releases features,
enhancements, and bug fixes that may affect how it works with library packages and with device
firmware. It's important to check that you are running with a version of CODESYS Development System
that is compatible with the Opto 22 Library Package. To check the version number, see the CODESYS
online help.

«  groov RIO Firmware. Opto 22 updates the firmware to add enhancements and features or to fix bugs.
Make sure to check the Readme file to learn whether it's compatible with the version of the Opto 22
Library Package installed in your CODESYS Development System. If you need to update RIO firmware, see
“Updating Firmware on a groov RIO” on page 96.

Updating Device Information with the Latest Version of Opto 22 Library Package

If this is the first time you are adding a groov RIO device to your project, you only have to do steps 1, 2, 10, and
11. If you are updating existing RIO devices in your projects, do all of the steps.
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Download and install the latest version of the library package from our website.
a. Gotothe Opto 22 website, www.opto22.com.

b. Enter “Opto 22 Library Package”in the search box to find the page “Opto 22 Library Package for
CODESYS Development System”and click the link.

c. Click Download and save the package to the same computer where you installed CODESYS
Development System.

d. Open CODESYS Development System and install the package. For instructions on how to do this,
see Installing/Uninstalling a Package in the CODESYS Online Help.

Review the readme for the Opto 22 Library Package for CODESYS Development System. Pay particular
attention to the following:

- Ifthe package requires a newer version of CODESYS Development System than your current version,
install the new version before proceeding further.

—  Make note of any additional tasks you may have to do after updating device information; for
example, installing a new version of RIO module firmware.

Remember: If you are adding a groov RIO device for the first time, you can skip down to step 10.

Open your CODESYS project and, in the Device tree, expand the RIO device to see all the channels.
Right-click the RIO device and select Update Device.

] PLC_PRG
= [ Eth1_RIO Ethernet)

~ [ [6RV_R7_MM1001_10 (GRV-R7-MMonsmam ]
Hj2 GROOV_CHANNEL (Digital In Cut
HiS GROOV_CHANNEL _1 (Digital Copy
WHE GROOV_CHANNEL 2 (Digital paste
Hi2 GROOV_CHANNEL 3 (Digital
HJS cROOV_CHANNEL_4 (Analo
HJZ GROOV_CHANNEL S (Analo: Refactaring

*  Delete

MY GROOV_CHANNEL_7 (Digital Properties...

L <Emty7s Add Object
HiS GROOV_CHANNEL 6 (Digital
£ <Emptyo> ) Add Folder...
(il Ethernet (Ethernet) Insert Device...
Disable Device
(] EditObject

Edit Object With...

If the Update Device window does not automatically select the correct RIO device, navigate through the
window to find it and select it.

Click Update Device.

CODESYS Development installs the new information about the RIO device. Now you need to update device
information for each channel:

7.

Right-click on a configured channel on the RIO device and click Update Device.

o] PLC_PRG
= [ Eth1_RIO Ethernet)

= [EW GRV_R7_MM1i001_10 (GRV-R7-MM1001-10)
M5 [GROOV_CHANNEL {Digital

M5 GROOV_CHANNEL _1 (Digit{ & oo
M5 GROOV_CHANMEL _2 (Digit{ Copy
M5 GROOV_CHANMEL _3 (Digit{ Paste
2 GROOV_CHANNEL 4 (Anah 3¢ pelee
HiZ GROOV_CHANNEL S (nal
HjE GROOV_CHANNEL _7 (Digit}

Refactoring

K <Empty7s Properties...
o .
HiS GROOV_CHANNEL 6 (Digit{ Add Object
K <Emptys>
) Add Folder...

(il Ethernet (Ethernet)
Plug Device...

Disable Device

Update Device...
1" Editobject
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8. Inthe Update Device window, select the same device type (if it's not already selected). If applicable,
choose the highest version number. Click Update Device.

9. Repeatstep 7 and step 8 for each channel on the RIO.
10. Save your project.

11. Ifyou noted any additional tasks in step 2, make those changes now. Then, rebuild your project, test the
changes, and verify that your application works as expected.

Adding a groov RIO to a CODESYS Project

Before you begin, verify that the PLC and the RIO are on the same network.
1. Open CODESYS Development System.

2. Open your project. (Click File > Open Project. Navigate to the folder where you stored the project file,
select the project file, and then click Open.)

3. Addan Ethernet adapter to your PLC. With this adapter, you will identify which port on the RIO
communicates to the PLC.

Right-click on your PLC.

Click Add Device.

Under Fieldbusses, expand Ethernet Adapter, then click Ethernet.

Click Add Device.

Click Close.

Double-click the Ethernet adapter to open the Ethernet Adapter’s object view.
Click the More button (| =) next to the Interface field.

@ ™~p oo gy

Ethernet Adapter's object view

Devices > B X [ Ethernet x
=5 Frst RIO_Project ~
= General
e ] S—
=-&1 PLC Logic st
. atus
= €} Application IpAddress 192 .18 . 0 . 1
i) Library Manager Ethernet Device 1/0 Mapping Subnet Mask 255 . 255 . 255 . 0
PLC. PRG (FRG)
DefaultGateway | 0 . 0 . 0 . 0
=B Task Configuration Etheret Device IEC Objects
T p— Adjust Operating System Settings
&) rLc_PRG Information

[ Ethernet (Ethernet)

The Ethernet Adapter added in steps a through e.

h. Select ethO or eth1, whichever port is connected to the network.
i. Click OK.
4. Addthe RIO to the Ethernet adapter:
Right-click on the Ethernet adapter you just added.
Click Add Device.
Expand Miscellaneous and select a RIO by its part number. For example, GRV-R7-MM1001-10.
Click Add Device.
Click Close.
5. Assign the RIO's IP address to the address parameter of the device.

poon oy

a. Double-click the RIO device you just added. CODESYS Development System opens the object view.
If the Parameters tab is not selected, then select it.

groov RIO User's Guide



CHAPTER 8: CONFIGURING 1/0

b. Click on the Value column for the Address parameter. Enter either the hostname or the IP address of

the RIO, surrounded by single quotes.

Object view of the RIO device added in step 4.

| Devices. > 3 X [ Ethemet cnvk»\mumn,m x
=5 Arst RIO Project - T
= Device (GRV-EPIC-PR1) GRV-R7-MM1001-10 /O Mapping Parameter Type Value DefaultVal.. Unit Description
=-B0 pLc Logic ; % Address STRING(255) ‘opto-00-00... ‘opto-00-00... 1P Address or hostniame of the 1/O unit. Use '127.0.0. ' for local 1/0.
=3 Application SRVRATMIDILIGIEC Oblects & Port UINT 2001 2001 OptoMMP Port
() Library Manager ERV-RT-MML001-10 Parameters # Communication Timeout (ms) DWORD 1000 1000 Masximum time for the 1/0 unit to respond in milliseconds
PLC_PRG (PRG) # Watchdog Timeout (ms) DWORD 0 0 1/0 Uit commurication watchdog timeout (0 is off, non-D is tmeoutin ms)
= (8 Task Configuration S & Temperature Units Enumeration of DWORD ~ Degrees Ce... Degrees Ce Temperatures can be read in degrees Celsius or degrees Fahrenheit.
=& MainTask # Enable Configuration BoOL TRUE TRUE FALSE also disables configuration for al child modules.
& pLC_PrG Information  Streaming Interval (ms) DWORD 20 Bl Rate at which input data wil be published by the 1/0. NOTE: It is highly advisble to us
= [ Ethernet (Ethernet) # Debug Level Enumeration of DWORD Nene None Controls the amount of debugging information logged as INFO messages.
= GRV_R7_MM1001_10 (GRV-R7-MM1001-10) # Auto-Reconnect BOOL TRUE TRUE Automatically attempt to reconnect after a communication faiure.
K <Empty0>
K <Emptyiz
R

The RIO device added in step 4.

6.

Save your project.

Adding Channels and Selecting Signal Types (Plugging in Devices)

To configure a channel, you “plug in"a device to your RIO. Now is when you need the information you
collected when you reviewed “Selecting Functions, Signals, and Features”on page 59.

1. Right-click on a channel (empty slot) and select Plug Device.
Remember to pay careful attention to the channel you select; remember that not all channels support all
functions, signal types, or features.

2. Inthe Plug Device window, expand Miscellaneous, then select which signal you want to assign to that
channel (device).

3. (Click Plug Device.
You can continue adding/configuring channels by clicking on another channel, selecting a signal type in
the Plug Device window, then clicking Plug Device.

4. C(lick Close when you are done.

Changing Signal Types (Updating Devices)

If you want to change signal type you assigned to a particular channel (device):

1. Right-click on the channel and select Update Device.

2. Inthe Update Device window, expand Miscellaneous, then select the new signal you want to assign to
that channel (device).

3. (lick Update Device.
You can continue changing signal types by clicking on another channel (device), selecting a new signal
type in the Update Device window, then clicking Update Device.

4. C(lickClose.

Setting Features (Configuring Object Parameters)

In CODESYS Development System, a groov RIO feature is identified as an object’s parameter. For example, an
analog ICTD Temperature signal has several features, which are listed in the table on page 68. In CODESYS
Development System, you would see these features listed as parameters in the Parameters tab of the object
View.
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Device Aj  GROOV_CHANNEL A GROOV_CHANMNEL _1 A GROOV_CHANNEL_2 X 'ai GROOV_CHANMEL_3 A GROOV_CHS
Parameters Parameter Type Value  DefaultValue Unit  Description
i = & Channel Configuration
1/ Mapping @ Channel Type DWORD 1660000031 1660000031
[EC Objects @ Upper Scaled REAL
@ Lower Scaled REAL
Status A  Offset REAL 0.0 0.0
@ Gain REAL 1.0 1.0
Information @ Filter Weight (0=disable) REAL 0.0 0.0
Parameters Parameter Type Value Default Value Unit  Description
= & Channel Configuration
oM i
{ORapping % Channel Type DWORD 16#9... 16#90000078
[EC Objects = & Watchdog Configuration BYTE 1]
@ Watchdog Enable BOOL FALSE FALSE
Status B @ Watchdog Value BOOL FALSE FALSE

Information

A Features for an ICTD signal on a channel of a GRV-R7-MM1001-10. Compare the parameters list with
the list of features on the table for an analog input ICTD signal. All but two features are available on
CODESYS.

B Features for a digital output signal on channel 0 of a GRV-R7-MM1001-10. Compare the parameters
list with the list of features on the table for a digital output DC sinking signal. Only one feature is
available on CODESYS: Watchdog Timeout Value.

The following table lists the features for the functions and signal types that you can select and configure on a
GRV-R7-MM1001-10.

Function Signal Types Features
« Digital Channels 0-7:
- * Switch Input, powered ¢ On/Off State
Digital Channels 0 & 1:
* Counting
Input .
Channels * Voltage * Scaling
e Current » Offset and Gain
Analog * ICTD * Average Filter Weight
* Thermocouple
 Millivolt
- * DC Sinking ¢ On/Off State
Digital ’
* Watchdog Timeout Value
e Current * Scaling
Output Analo * Voltage * Clampin
Channels 9 9 ping .
* Watchdog Timeout Value
Mechanical ¢ Form C-NO * On/Off State
Relay ¢ Form C-NC * Watchdog Timeout Value

For a list of the signal types and features for all RIO models, see Appendix A: Specifications. If a feature listed
in that appendix is not listed in the Parameters tab of the object view, the feature is not configurable through
CODESYS Development System.

Configuring Channel Features (Device Parameters)
1. Ifyou haven't started CODESYS Development System, start it and open your project.
2. Open or select the Devices view, then expand the Ethernet branch of your groov RIO.
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3. Double-click the device (channel) you want to configure. CODESYS Development System opens the
object view for that device. Check that the Parameters tab is selected.

4. Find the parameter (feature) you want to configure:

- For devices (channels) with scaling: If you want to set scaling values, first determine the upper
and lower ends of the scale. For example, if your input range is + 150 mV and it is connected to a
tank that can hold 1000 liters, you can set the lower end of the scale (-150 mV) to represent 0 liters
and the upper end of the scale (+150 mV) to represent 1000 liters. With a signal type of Analog In
+150 mv (for example, on a GRV-R7-MM1001-10):

—  On the Upper Scaled row, double-click the Value cell and enter 1000.
—  On the Lower Scaled row, double-click the Values cell and enter 0.
To set default scaling, leave the Value cells blank or enter 0.

- For devices (channels) with clamping: If you want to limit the output sent out from the device
(channel), first determine the upper and lower end of that range. For example, suppose you want
the output range to be 5-15 mA. On a signal type of Analog Out 0-20 mA (for example, on a
GRV-R7-MM1001-10), to limit the range to 5-15 mA:

- Onthe Upper Clamp row, double-click the Value cell and enter 15.
—  Onthe Lower Clamp row, double-click the Value cell and enter 5.
To set no clamping, set both Values cells to 0.

—  For devices (channels) with counting: If you want to use the counting feature, you must select it.
On the Feature row, double-click the Value cell to display the drop-down arrow.

Parameter Type Value Default Value  Unit
= & Channel Configuration

@ Channel Type DWORD 16%5 55 1650000068

@ Feature Enumera... MNone

Click the arrow to display a list, then select Counter.

Parameter Type Value Default Value Unit  De:
= & Channel Configuration

@ Channel Type DWORD 16#5 58 06:
@ Feature Enumera... MNone

Counter k

5. Repeat step 4 for each device (channel) you want to configure.
Remember to save your project periodically.

If you haven't already done so, wire your field devices to your RIO as described in “Connecting Field Devices”
onpage 11.
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UNDERSTANDING HOW QUALITY ERRORS ARE REPORTED

Some signal types on a groov RIO can report quality errors, which are common errors like input values that are
out of range. groov Manage can show you that there is a quality error in the /0 Channels page by highlighting
the channel yellow and showing brief message about the quality error.

70

Viewing Information About a Quality Error

Log into your groov RIO with a user ID that has administrator privileges.

2. Click1/O Channels. groov Manage displays the list of channels and highlights the channel that is
reporting the quality error with a yellow background.

GrOOVMANAGE
£ Home 1/O Channels

0 <noname>
OFF

1 <noname:>

DI OFF

2 QOven_Temp

Al Invalid Value A

3 <noname>
OFF

4  <noname:>
OFF

5 <noname:>
OFF

=]

== =}

6 <noname>

DI OFF

7 <noname:>
DI OFF
8 <noname>
DO OFF

< No name >

9
oo TN

Click on that channel.

3. groov Manage displays the specific information about that channel:

GrCOVMANAGE =
£ Channels Channel 2 Configure
Name Oven_Temp
Module Type GRV-R7-MM1001-10
Channel Type ICTD Temperature Probe

Analog Input.

Value Invalid Value
Unit: Degrees C

Minimum -232.54
Maximum -232.54
Quality Error Code #6

Reporting out-of-range designator - below operating limits.

Fast Updates

Updates this view very quickly, but may affect system performance.

The Quality field shows you a message with an error code number and a possible reason for the error.
This information can help you troubleshoot problems with a field device wired to that specific channel.
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WHAT IS MQTT?

MQTT is a publish/subscribe (pub/sub) protocol that’s suited to many lloT applications because of its
architecture.

In a pub/sub architecture, a central source, called a broker, receives, distributes, and in some cases, retains
data. MQTT clients can publish data to the broker or subscribe to get data from a broker (or both). Clients who
publish data send it only when they choose to publish. Clients who subscribe to data automatically receive it
from the broker only when the publishers sends data.

Contrast this with a client/server architecture. With this architecture, the client and server must be connected,
because the client requests data directly from the server. The client doesn’t know when the data changes, so it
must request it at regular intervals.

MQTT pub/sub offers three main advantages over client/server for loT applications:

«  Network traffic is reduced overall because data is published and sent only when it changes, rather than at
regular intervals.

»  Because the broker s a central source that manages data, the broker can take over the data management
workload typically handled by a server in a client/server model, and the server now handles fewer clients.
And even remote devices with irregular connections or low bandwidth can publish or subscribe to data.
If a publisher can’t connect to the broker, for example, the publisher can optionally buffer its data and
send it at a later time.

«  Fordata publishers and subscribers, there's another important advantage: data is published and
subscriptions are initiated through an outbound connection. Most firewalls block inbound connection
requests (for example, an external OPC client requesting data from an internal OPC server), but they allow
outbound connections over secure TCP ports. A device (in this case, RIO) initiates an outbound
connection through a secure port, and the traffic travels both directions through that connection.

See mqtt.org for more information about the protocol.

MQTT on groov RIO

One of the features of MQTT is that the data (payload) it transmits can be in a format best suited for the
application. groov RIO can transmit payloads formatted to meet the Sparkplug-B specification or formatted as
strings. In addition, RIO offers several features and capabilities to suit a variety of application requirements.

Review the following list of features and capabilities and select the option that best suits your application:
«  MQTT with string payloads—Select this option if:

- Your application requires that the payload be formatted as a string.

- Your application is simple, perhaps monitoring or controlling only a few devices.
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- Your application requires automation data from groov RIO, but not from other PLCs.

- You are looking for a cost-effective option. This option does not require the purchase of additional
licenses.

With this option, you will need to:

- Convert data within your application. With payloads formatted as strings, you will need to add logic
to your application to convert strings to the correct data type, when necessary.

—  Define the topic namespace.

«  MQTT with Sparkplug payloads published from groov RIO—Select this option if:
- Your application requires that the payload be formatted to comply with the Sparkplug specification.
- Your application requires automation data from groov RIO, but not from other PLCs.

- You are looking for a cost-effective option. This option does not require the purchase of additional
licenses.

With this option, you'll be able to queue data into RAM if network connectivity is lost, which will then be
transmitted when the service is available. However, because the queued data is stored in RAM, it can be
lost when power is cycled or space runs out.

Keep in mind that you will need to:
—  Define the topic namespace.
- Provide the MQTT configuration information through groov Manage and then enable the service.

Note that you cannot combine these two options; you must choose one or the other.
«  For MQTT with string payloads, see “Configuring and Enabling MQTT with String Payloads”on page 72.

«  For MQTT with Sparkplug payloads published from groov RIO, see “Configuring and Enabling MQTT with
Sparkplug Payloads from groov RIO” on page 75.
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To connect your groov RIO to an MQTT infrastructure, you will need to:

«  Create a new MQTT broker or establish access to an existing one. The broker can be located on your
premises or in the cloud. You can search the Internet for information from various vendors about MQTT
brokers; setting up an MQTT broker is not covered in this guide.

«  Configure and start the MQTT service through groov Manage.

Before configuring, it's helpful to first collect information about the MQTT broker, determine some identifying
information for RIO, and review settings that may affect transmission performance.

Collecting Information

Collecting information about the MQTT broker

You'll need the following information about the MQTT broker:
«  Broker URL—The URL of the MQTT server

«  ClientID— (Optional) Enter a client ID only if one was supplied. If you do not enter a client ID, the MQTT
service will generate one.

«  Username—The username you need to access the broker
«  Password—(Optional) If required, the password you need to access the broker

«  SSL—If your MQTT server requires SSL, you need to upload the correct SSL certificate to your groov RIO
before you begin configuring the MQTT service. For instructions, see “Managing the SSL Security Features
of your groov RIO"on page 24.

«  Keep Alive (s)—The number of seconds between heartbeats.
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Specifying Default Topics for groov RIO

You'll need to collect or create the following information to uniquely identify your groov RIO in your MQTT
infrastructure. If necessary, consult with someone who assigns topics to determine if RIO will be assigned a
specific set of topics, and whether you should follow a particular naming convention. All of the following
information is required:

«  MQTT Base Topic—The base topic is prefixed to the MQTT topic used to publish data.
«  MQTT Group Topic—Identifies the group that your groov RIO belongs to
«  MQTT Subgroup Topic —Identifies a subdivision within the group

In addition, you'll need:
«  MQTT Device Topic—Identifies your groov RIO within the subgroup

«  Use Comma in Floats—If your application uses a comma to separate values (for example, pi is denoted
as 3,14 instead of 3.14), you'll want to indicate that when you enter configuration information in
groov Manage.

Reviewing groov RIO Performance Settings

You may want to review the following settings, which can affect throughput in an MQTT infrastructure.
Changing the settings can help you fine-tune throughput:

«  CommTimeout (ms)—The default connection timeout value is 5000 milliseconds. You can adjust this
value to account for slower or faster infrastructures. (For example, if your groov RIO is in an area with
“spotty”or slow connection, you may want to increase this value.) Minimum is 1000; maximum is 30,000.

«  Scan Time (ms)—The scan interval in milliseconds. You may need to adjust this if the scans can't finish
before the time is up.
Configuring and Enabling MQTT Service

Make sure you are logged into your groov RIO with an ID with administrator privileges before starting:
1. From the groov Manage Home page, click MQTT, then Configuration.

GroOVMANAGE =
< Cancel MQTT Save
Edge Node
MQTT Payload MQTT with Sparkplug payloads
Group ID Required

The Sparkplug Group ID

Edge Node ID Required
The Sparkplug Edge Node ID

Primary Host ID Optional

Compression none

Add MQTT Broker
Add Device

@ Delete Configuration

2. Inthe Edge Node section:
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a. Click MQTT Payload.

MQTT Payload

+ MQTT with Sparkplug payloads

MQTT with string payloads

Cancel

b. Click MQTT with string payloads.

groov =
€ Cancel MQTT Save
Edge Node
MQTT Payload MQTT with string payloads
MQTT Base Topic Required
MQTT Group Topic Required

The group topic namespace in the MQTT Folder structure

MQTT Subgroup Topic Required
The subgroup topic namespace in the MQTT folder structure

Use Comma in Floats
Add MQTT Broker
Add Device

T Delete Configuration

Enter the information you collected in “Specifying Default Topics for groov RIO"on page 73.
3. Click Add MQTT Broker.

5 MQTT Broker E
Broker URL tepy/1.2.3.4:1883

Client ID e.g. any_unique_id
Username Required
Password Optional
SSL

ConnTimeout (ms) 5000
Keep Alive (s) 10

Cancel | Delete | OK

Enter the information you collected in “Collecting information about the MQTT broker”on page 72. Click
OKto close the MQTT Broker window and return to the MQTT page.
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4, (lick Add Device.

5 Device E
MQTT Device Topic e.g. any_unique_id

The MQTT device topic name

CommTimeouk(ms) 5000
Scan Time (ms) 1000
Additional Host Tasks Optional

Cancel | Delete | OK

USE LOmMME TN Foats T—

Enter the information you collected in “Reviewing groov RIO Performance Settings”on page 73.

Note: Ignore the Additional Host Tasks field; RIO does not have host tasks.

5. Click Save. groov Manage validates the information you entered.

MQTT configuration saved. Do you want to start the service?

If it passes this validation, click Yes to confirm that you want to save these settings and start the MQTT
service. This may take a minute. When it is done, groov Manage displays the MQTT page.

CONFIGURING AND ENABLING MQTT WITH SPARKPLUG PAYLOADS FROM groov
RIO

To connect your groov RIO to an MQTT infrastructure, you will need to:

«  Create a new MQTT broker or establish access to an existing one. The broker can be located on your
premises or in the cloud. You can search the Internet for information from various vendors about MQTT
brokers; setting up an MQTT broker is not covered in this guide.

«  Configure and enable the MQTT service through groov Manage.

Before configuring, it's helpful to first collect information about the MQTT broker, determine some identifying
information for RIO, and review settings that may affect transmission performance.

Collecting Information

Collecting information about the MQTT broker

Collect the following information about the MQTT broker:

«  Broker URL—The URL of the MQTT server

«  Client ID— (Optional) Enter a client ID only if one was supplied.

«  Username—The username you need to access the broker

«  Password—(Optional) If required, the password you need to access the broker.
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o SSL—If your MQTT server requires SSL, you need to upload the correct SSL certificate to your groov RIO
before you begin configuring the MQTT service. For instructions, see “Managing the SSL Security Features
of your groov RIO” on page 24.

«  ConnTimeout (ms)—The default connection timeout value is 5000 milliseconds. You can adjust this
value to account for slower or faster infrastructures. (For example, if your groov RIO is in an area with
“spotty” connection, you may want to increase this value.) Minimum is 1000; maximum is 30,000.

«  Keep Alive (s)—The number of seconds between heartbeats. If there is no heartbeat for longer than the
keep alive time, the last will and testament is sent.

«  Compression—If you must compress the payloads before they are published to the MQTT server,
determine if it uses gzip or deflate.

Specifying Unique Identifiers for groov RIO and Other Settings

You'll need to collect or create the following information to uniquely identify your groov RIO in your MQTT
infrastructure. If necessary, consult with someone who assigns these IDs to determine if the processor will be
assigned a specific set of IDs, and whether you should follow a particular naming convention.

«  Group ID—Identifies the group that your groov RIO belongs to
«  Edge Node ID—Identifies a subdivision within the group
«  Device ID—Identifies your groov RIO within Edge node

You may also need the Primary Host ID, which enables notifications as to the “state” (offline or online) of the
MQTT server.

Reviewing Performance Settings

You may want to review the following settings, which can affect throughput in an MQTT infrastructure.

Changing the settings can help you fine-tune throughput:

«  CommTimeout (ms)—The number of milliseconds that the MQTT service waits for RIO to respond to a
request. If you set this value too small, you may see erratic communication timeouts.

«  Scan Time (ms)—The scan interval in milliseconds. You may need to adjust this if the scans can't finish
before the time is up.

«  Historic Queue—The maximum number of Sparkplug publications that may be historically queued
when the connection to the broker fails. The value may range from 0 to 65535. You may want to change
this value after considering the following factors:

—  The publications are stored in RAM, so storage can be consumed quickly when you specify a large
value. Also keep in mind these three factors that can influence how many Sparkplug publications
are created: how many tags are scanned, the scan rate, and the rate of tag changes.

—  Ifthe number of publications exceeds this value, the oldest entries are discarded to make room for
newer entries.

Configuring and Enabling MQTT Service

Make sure you are logged into your groov RIO with an 1D with administrator privileges before starting:
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From the groov Manage Home page, click MQTT, then Configuration.

GrooVMANAGE =
< Cancel MQTT Save
Edge Node
MQTT Payload MQTT with Sparkplug payloads
Group ID Required

The Sparkplug Group ID

Edge Node ID Required
The Sparkplug Edge Node ID

Primary Host ID Optional

Compression none

Add MQTT Broker
Add Device

@ Delete Configuration

If MQTT with Sparkplug payloads is not listed in the MQTT Payload field, click on the field and select it

from the MQTT Payload window.

In the Edge Node section, enter the information you collected in “Specifying Unique Identifiers for groov

RIO and Other Settings” on page 76.

The Sparkplug Group ID

Edge Node ID Required
The Sparkplug Edge Node ID

Primary Host ID Optional

Compression none

GrooVMANAGE =
< Cancel MQTT Save
Edge Node
MQTT Payload MQTT with Sparkplug payloads
Group ID Required

Click Add MQTT Broker. In the MQTT Broker page, enter the information you collected in “Collecting

information about the MQTT broker”on page 75.

Click OK.

i MQTT Broker ‘
Broker URL tepy//1.2.3.4:1883
Client ID e.g. any_unique_id
Username Required
Password Optional
SsL
ConnTimeout (ms) 5000
Keep Alive (s) 10

‘ Cancel  Delete = OK

Controller
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4, (lick Add Device.

I Device I

~ DevicelD e.g. any_unique_id =
The Sparkplug Device ID

CommTimeouk(ms) 5000
Scan Time (ms) 1000
Additional Host Tasks Optional
Historic Queue Optional

Cancel Delete oK

Add MQTT Broker

Enter the information you collected in “Reviewing Performance Settings”on page 76.

Note: Ignore the Additional Host Tasks field; RIO does not have host tasks.

5. Click Save. Confirm that you want to save these settings and start the MQTT with Sparkplug service. This
may take a minute. When it is done, groov Manage displays the MQTT page.

6. Enable the service by clicking Enable in the MQTT Status section.
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If you are new to Node-RED, it might be helpful to review our Automation 101 video introducing Node-RED:
Intro to Node-RED: Part 1 - Fundamentals. (You can find other videos in the Support > Videos section of our
website, www.opto22.com.) The “Learning to Develop a Node-RED Flow" section (below) will take you
through a hands-on approach to learning how to develop a Node-RED flow. However, before you can begin
those exercises or do anything else with Node-RED on your groov RIO, make sure you:

»  Enabled Node-RED as described in “Enabling Node-RED" on page 56.

«  Configured the channels on your RIO by one of the following methods:
- Asdescribed in Chapter 8: Configuring I/0.
- Configured through a PAC Control strategy.
- Configured through a custom control program.

FOR EXPERIENCED Node-RED DEVELOPERS

If you have experience developing Node-RED flow and just want to know which node to install to access I/0
on your groov RIO, it is node-red-contrib-groov-io. This node can also access I/0 on groov I/0 modules
mounted on an EPIC chassis.

You might also find the following nodes helpful:
« node-red-contrib-groov. Nodes to access a Data Store in a groov View project.

« node-red-contrib-pac. Nodes to access tags and strategy information from a PAC Control strategy
running on a groov EPIC processor or SNAP PAC controller.

These are the URLs to access the Node-RED Editor in groov RIO:

. https://[your groov RIO’s hostname]/node-red
. https://[your groov RIO’s IP address]/node-red

LEARNING ABOUT Node-RED ON RIO

Opto 22 provides Node-RED nodes to access groov RIO I/0; the same nodes can also access I/0 on a

groov EPIC processor. Opto 22 also provides Node-RED nodes to access data in groov View Data Stores, as well
as nodes to access strategy information from PAC Control strategies running on groov EPIC processors or
SNAP PAC controllers. For more information on nodes, see developer.opto22.com.

Node-RED Editor. You can include one or many flows in your Node-RED project, which you build in the
standard, browser-based Node-RED Editor. You can access the editor directly through a URL or navigate to it
through groov Manage.
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LEARNING TO DEVELOP A Node-RED FLOW

Debugging. With few programming restraints, it's easy to accidentally introduce bugs into your flow. The
Node-RED Editor can help you debug flows. If Node-RED crashes, it automatically restarts. You can also start
and stop Node-RED yourself from within groov Manage.

Files. Your Node-RED project consists of two files: the main file with all your flows, and a separate file
containing all the sensitive credential information used by some nodes, such as usernames and passwords for
an email node. groov RIO provides ways to backup and restore Node-RED projects, either separately or as part
of the complete backup and restore.

LEARNING TO DEVELOP A Node-RED FLOW

If you are new to Node-RED, this section takes you step-by-step through the following exercises:
«  Learning the different ways to open the Node-RED Editor in groov RIO.

«  Creating a basic flow to display a timestamp; deploying the flow, operating a node, and observing its
behavior; then enhancing the flow to modify the format of the timestamp.

«  Adding nodes that can collect data from your RIO, a groov View Data Store, and a PAC Control strategy.
«  Creating and deploying a flow that accesses tag values from a fictional PAC Control strategy.

Before you start these exercises, make sure you enable Node-RED (see “Enabling Node-RED"on page 56) and
that your groov RIO has access to the Internet.

Opening the Node-RED Editor

You can open the Node-RED editor with either of the following methods:
«  Open aweb browser and enter either of the following in the URL bar:
— https://[your groov RIO’s hostname]/node-red
—  https://[your groov RIO’s IP address]/node-red
Don't forget the “s"in https. Examples:
-  https://opto-00-d2-da/node-red
- https://192.0.2.20/node-red

« Ifyouare in groov Manage, click the menu button (E), then select Home. From the Home page, click
on Node-RED, then Open Node-RED Editor.
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If you are new to the Node-RED Editor, take a moment to review the following diagram to familiarize yourself
with the different parts of the editor.

Nodes palette Workspace Menu

=<, Node-RED

Flow 1 + || = i info i x| -
~ common ~ Information
Flow "293eaBed b6065E"
inject
Name Flow 1
debug Status Enabled
complete ~ Description
catch
status
link in
link out
comment TlpS
z| % box
~ function
function
switch - >

Creating a Flow

1. Inthe Nodes palette on the left, locate the inject node. Click and hold on it, then drag it to the workspace.
The inject node lets you inject messages into a flow, either by clicking the button on the node or by
setting a time interval between injects.

The info tab on the right side-bar displays information about the inject node’s properties and a
description of what it does:

=<2 Node-RED =T Deploy ~
Flow 1 + = i info i | -
~ common ~ Information
- Flow "293eabcd.b60658"
L Name Flow 1
debug timestamp Status Enabled
complete v Description
catch
status
link in
link out
comment
~ function
function
switch - > :

You might want to close the Tips box so that you can see more information in the info tab.
2. Scroll down in the Nodes palette and locate the debug node. Drag it to the workspace.
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3. Wirethe inject and debug nodes together by dragging from the output port of inject to the input port of

debug.
=<, Node-RED =7 Deploy ~
Flow 1 + || = i info i | -
~ common ~ Information
Flow '293eabed b6065E"
inject
o] Name Flow 1
timestam| msg.payload
debug J L Status Enabled

Deploying the Flow and Testing It

The nodes exist only in the editor and must be deployed to the server.

1. Click the Deploy button in the upper right.

2. Inthe right-sidebar, select the debug tab. (If you can't see the debug tab, click )
3. (lick the button on the left side of the inject node.

Numbers appear in the sidebar:

=<2, Node-RED

Flow 1 + = 4 debug il -
~ common T all nodes )
inject

debug @

complete

]
timestamp msg_payload

This number is a timestamp representing the number of milliseconds since January 1, 1970. This is the
default payload of the Inject node.

Adding a Function Node

Let's make the timestamp more readable by using a Function node. Function nodes let you pass each
message though a JavaScript function. If you don't know JavaScript, you may be able to find code you need
using an Internet search.

1. Find the function node in the Nodes palette.

2. (lickand hold on the function node, then drag it to the workspace, placing it between the inject and
debug nodes. When the wire between the inject node and debug node becomes a dashed line, let go of
the mouse button. The Node-RED editor automatically wires the Function node to the inject node and
the debug (msg.payload) node.

=<, Node-RED
Flow 1 + || = % debug i -

~ common T all nodes ]

inject

]
timestamp msg.payload
debug

complete
catch

status

82 groov RIO User’s Guide



CHAPTER 10: DEVELOPING NODE-RED FLOWS

If you didn't see a dashed line:

a. Drop the function node near the inject and debug node.

b. Delete the existing wire by selecting it and pressing Delete on the keyboard.

c. Add a wire to link the output of the inject node to the input of the function node.

d. Add awire to link the output of the function node to the input of the debug (msg.payload) node.
3. Double-click the Function node to edit it. The Node-RED editor displays the Edit function node panel.

Q Edit function node ¥ debug i |l o~

L e
"L e | Delete Cancel m ¥ current flow a

| link in
e | 7:24:58 PM node: fcce4ba.cb516b3

i =]
O link out # Properties 2B ad - number
1587349498847
comment
¥ Name &~
v function # Function
1

e 2 return msg;

switch

change

s
T
i
T
§
T
L range
T g
I

T

i

(& template 8 Outputs 1 :
o]

delay
QO Enabled =]

In the Name field, type Human Date.
5. Copy the following code into the Function field, at line 1:
// Create a Date object from the payload
var date = new Date (msg.payload);
// Change the payload to be a formatted Date string
msg.payload = date.toString() ;
6. Leave this code in place at the end:
return msg;
7. Click Done to close the edit dialog box and then click the Deploy button.
8. Now when you click the Inject button, the message in the sidebar shows a more readable time stamp:

4 debug il -

Q Flow 1 +

~ common T all nodes ]

47202020, 7:55-40 AM  node: 90b5947¢.14edes

[ e i
| inject 0 msg payload - number

E @ timestamp [ - :E [ ] 1587394540863

4/20/2020, 7:57:41AM  node: 90b5947c. 14eded

‘ complate i msg payload - siring[62]
) “Hon Apr 2@ 2020 14:57:41 GMT+0000
- rdinated Universal Time)"
calch — (Coordinsted )
o= S rumcn e 2>

status

Installing groov I/0 Nodes

groov 1/0 nodes can read and write data from your RIO or from /O modules on an EPIC.
1. Click the menu button (E), then select Manage palette.

2. (lickthe Install tab.

3. Inthesearchfield, enter groov.
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Install tab
Search field
User Settings i info
~ Information
"293eaBcd b60658"
View Nodes Install
Name Flow 1
[+
Keyboard Status Enabled
a 2557
greod v Description
Palette -
© node-red-contrib-groov ngO\/ \/|eW nodes
Node-RED nodes for Groo w, the mobile operator interface from
Opto 22
S 110 B 2years 1 ag install
& node-red-contrip-groov-io &
Node-RED nodes for groov /0 groo\/ VO nOdeS
% .01 B 4months ago install

Find node-red-contrib-groov-io inthe listand click the Install button next to it.

5. The Node-RED Editor displays a message about checking dependencies and reviewing node
documentation. Click Install. When installation is finished, the small Install button changes color to gray
and changes text to Installed.

While you are here, you can also install the groov View nodes. This will help you save some steps in the next
section, “Installing groov View Nodes to Access Data Stores” on page 85. The following image shows both nodes
installed.

User Settings i info ([ [l -
v Information -
o "a5dcsci2.fata’
View Nodes Install
Name RIO Samples
sort:| |F | az | recent =
Keyboard Status Enabled
Q 2/2587
e . ~ Description
Palette -

© node-red-contrib-groov &

w, the mobile operator interface from Opto 22

@ node-red-contrib-groov-io &
Node-RED r r groov /O

6. Click Close.

The new groov 1/0 and groov View nodes appear in the nodes palette, under the heading Opto22.

groov RIO User's Guide



254
1/0

CHAPTER 10: DEVELOPING NODE-RED FLOWS

groov ’o wHe 0

Installing groov View Nodes to Access Data Stores

groov View nodes can read and write data from a groov View Data Store. For an introduction to Data Stores and
how to create them in groov View, see “Adding a Data Store”in the groov View User's Guide (form 2027). After
you create the Data Store in groov View, you can access the Data Store in your Node-RED flow by accessing the
groov View project that contains the Data Store.

Ifyou already installed the node-red-contrib-groov nodes to the Node palette when you went through “Installing
groov /0 Nodes” on page 83, you can skip to the next section.

1. Click the menu button (E), then select Manage palette.
2. (lick the Install tab.
3. Inthesearch field, enter groov.

User Settings

View

Keyboard

Palette

Install tab
- =T Search field
i iInfo k3
- Information
"293ea8cd b60858"
Nodes Install
Name Flow 1
Status Enabled
2 grooy v Description
© node-red-contrib-groov & grOOV\/ieW nodes
Node-RED nodes for Groov View, the mobile operator interface from
QOpto 22
% 1.1.0 B 2years 1 month ago install
© node-red-contrib-groov-io
Node-RED nodes for groov 110 groov I/0 nodes
® 101 B 4monthsago

4. Find node-red-contrib-groov inthe listand click the Install button next to it.

The Node-RED Editor displays a message about checking dependencies and reviewing node
documentation. Click Install. When installation is finished, the small Install button changes color to gray
and changes text to Installed.

The following image shows both groov I/0 and groov View nodes installed.
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User Settings i info i [ (| |Lal| w
~ Information
Flow "a5dc5c12. fMata’
View Nodes Install
Name RIO Samples
sort: | IS | az | recent | &
Keyboard Status Enabled
Q 212887
ke = ~ Description
Palette -
© node-red-contl roov
Node-RED nod Groov View, the mobile operator interface from Opto 22
w 110
© node-red-contrib-groov-io &
Node-RED nodes for groov /O
% 101 B8 4months ago
5. Click Close.

The new groov I/0 and groov View nodes appear in the nodes palette, under the heading Opto22.

Q

RI

email
Y.

O emal |
L )

~ Opto22

‘
et
groov A g0

Installing Opto 22 PAC Control Nodes

For this section, you'll add nodes to establish real-world communication with groov View Data Stores and tags
in PAC Control strategies. You need either of the following:

«  AnOpto 22 groov EPIC processor running a PAC Control strategy, or

« a3 SNAP PAC S-series or R-series industrial controller with firmware R9.5 or higher, running a PAC Control
R9.5 or higher strategy.

For either of these options, you need to complete the configuration instructions on developer.opto22.com. At
the website, click on Node-RED for PAC Control, then expand Getting Started.

«  Forthe groov EPIC processor, click on groov EPIC Controller Configuration.
«  Forthe SNAP PAC controller, click SNAP PAC Controller Configuration.

As you complete the processor or controller configuration, make sure to save the following information:
«  APIKey Name and Value (for SNAP PAC)

«  APIKey (for groov EPIC)

«  Path and file name to the SSL Certificate

After you set everything up and gathered this information, you can start:

1. Install Node-RED for PAC Control nodes just as you installed the groov View nodes. (Menu > Manage
palette > Install tab. Search for node-red-contrib-pac.)

2. Make sure you have an inject and a debug node in the workspace.
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3. Near the bottom of the Nodes palette, click and hold on the pac read node and drag it to the workspace,
in between inject and debug (msg.payload).

The pac read node lets you read I/0 and variable data in the PAC Control strategy.
Wire the pac node to the inject node and debug node, in the same way you wired the Function node.
Click the node and click the info tab to see helpful information about the node.

o v »

Double-click the pac read node to edit it.

Edit pac read node

~ node properties

@ Device Add new pac-device || £
= Data Type Device Details v

# Value ~ msg.payload

= Topic ~ Do not alter

@ Node Name

7. (lick the pencil at the right of the Controller field.

Edit pac read node > Add new pac-device config node

@ Address HTTPS ~ |

& API Key Name

& API Key Value |

B SSL Cerlificates (PEM format)

CA or Self-Signed

Public Key

8. Complete the fields:
a. For Address, choose a protocol and enter the IP address of the groov EPIC processor or the SNAP PAC
controller.
b. Forthe APl Key Name and API Key Value fields:

- Ifyou are accessing tags from a PAC Control strategy running on a SNAP PAC Controller, enter
the API Key Name and Value you obtained when you configured the controller (as described
on the previous page).

- Ifyou are accessing tags from a PAC Control strategy running on a groov EPIC processor, enter
the API Key into the APl Key Value field. Leave the API Key Name field blank.

c. Forthe SSL Certificates (PEM format) fields:

- Ifyou selected HTTPS as the protocol, read the information in the info tab to determine what
to enter in these fields.

- Ifyou selected any other protocol, you can leave these fields blank.

d. Click Add.

The Node-RED editor returns you to the Edit pac read node panel, where your node is now configured to
access the I/0 and variable data in the PAC Control strategy running on the groov EPIC processor or the
SNAP PAC controller:
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Edit

pac read node

~ node properties

@ Device 192.0.2.20 v
EDataType | Digital Input v
% Tag Name
# Value ~ msg payload
= Topic ~ Do not alter
© Node Name
9. Choose the Data Type from the dropdown list.

The

data type determines what other fields appear. In this example we chose Analog Input, so a field

appears for Tag Name.

Edit pac read node

~ node properties

@ Device 192.0.2.20 v &

= Data Type Analog Input v

% Tag Name aiOvenTemperature

# Value ~ msg.payload
= Topic ~ Do not alter
O Node Name

d.
10. Click

groov RIO User's Guide

Tag Name—-Enter the exact I/0 point or variable name from the PAC Control strategy running on
this controller. If you leave this field blank, you'll receive values for all tags of this type (in this
example, all analog inputs).

Start Index and Length—For a table, enter the starting index and length of the data you want to
use.

Node Name—(Optional) By default, the tag name is used for this node. If you want to give it a
different name, enter it here.

Click Done.
the down arrow next to Deploy to see your choices.
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You can deploy everything, or if you don't want to disturb running
flows, you can choose to deploy only the changed flows or
changed nodes.

The gray box around the icon shows what will happen when you
click the Deploy button. In this example, everything is deployed
(Full).

11. Click Deploy. Now click the inject button and see what message appears in the debug tab.
You should see the data from your PAC Control strategy. Here's how our example looks:

de-RED for Opto 22

Q Flow 1 + info debug

v Opto22 all flows B

pac read timestamp  —— aiOvenTemperature ———  msg payload

101.904083

groov RIO User's Guide 89



LEARNING TO DEVELOP A Node-RED FLOW

90 groov RIO User's Guide



11: Maintaining a groov RIO

You'll want to maintain your groov RIO units regularly to keep them up-to-date, running smoothly, and to
make it easier to restore in the event of a reset:

«  Back up your information regularly
«  Apply firmware updates

If you encounter problems while operating your groov RIO unit, here are a few things you can do:

«  You can troubleshoot some problems and, if you can't resolve your problems, there are some steps you
can take to help Product Support solve your problems.

« Ifyou had to restore your processor to factory defaults, you can restore the information that you backed
up.

BACKING UP YOUR groov RIO SETTINGS

Recommendations vary regarding when and how often you should back up your groov RIO:
«  Before you apply a firmware update.

«  Before you change configuration, like channel function.

«  Periodically; for example, once a year.

Whichever recommendation you follow, the groov Manage Backup feature can save valuable configuration
information, which you can then restore at a future date.

However, keep in mind the following:

«  The backup feature saves only the first 10 MB of user files, which are files that either you uploaded
manually to the processor or were placed there by control programs.

«  While the backup feature does save your Node-RED projects (flows and credentials), it does not save any
nodes you installed; for example, Opto 22 nodes or nodes to access cloud services.

IMPORTANT: The backup file is not a secured or encrypted file. You must apply your own security or encryption
to the file to protect any sensitive information. Also, be aware that if you send a backup file to Opto 22 without any
security or encryption, our personnel will have access to all the information in that file.

After you select a back up folder or medium, do the following steps:

1. Onacomputer or mobile device that is connected to the medium or folder where you want to save your
back up file, log into your groov RIO with a user ID that has administrator privileges.

2. (lick Maintenance > Backup.
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On the Backup page, select the information you want to back up by moving the corresponding slider to
the right so that it shows green (@l ). By default, everything except Server SSL Certificates and
network configurations are backed up. If you do not want certain information backed up, move the slider
to the left so that it shows grey ( ).

- 1/0 Configuration—Saves the changes you made to the channels at the time you ran the backup.
—  Accounts—The user IDs and passwords, plus the scope of each user ID’s access.
- Networking—Saves all of the following:

- Hostname

—  The settings for the Ethernet 0 (ETHO) and WiFi.

- The settings for the OpenVPN Tunnel .

—  The settings for the Network Options (DNS server IP address(es) and domain name(s), gateway
IP address, the DNS order, and the gateway order).

This also includes sensitive information like the WiFi SSID and pre-shared key, and the OpenVPN
server login credentials. If you select this setting, it's important that you apply your own security or
encryption to the backup file to protect this information.

- Firewall—The firewall settings you selected, as well as any rules you created.

- Time—The time zone and time servers configurations.

- Node-RED—~Part of a Node-RED project can include a credentials file, which can contain sensitive
information like user names, passwords, and security keys. It's important that you apply your own
security or encryption to the backup file to protect this information.

Remember that any nodes you installed (like Opto 22 nodes or nodes to access cloud services) are
not included in the backup.

- MQTT/Sparkplug—The information you entered or selected when you configured your groov RIO
unit to work with Sparkplug.

—  Client SSL Certificates—The most recent SSL certificates you may have uploaded.

- User Files—Only the first 10 MB of files you uploaded manually or were placed there by control
programs. After you create the backup file, you can review the log file to see which user files were
stored in the backup file and which were not.

—  USB Settings—The enable and automount settings you chose.

—  Server SSL Certificates—The server SSL certificates include sensitive information, like the web
server's private key. If you select this setting, it's important that you apply your own security or
encryption to the backup file to protect this information.

Click Download Backup.

Navigate to the folder or media where you want to store the backup file. groov Manage includes the date

and time (in UTC) that you ran the backup as part of the file name. If you want to give it a different name,

change the name in the File name field. Click Save.

NOTE: Some browsers might automatically download the file to a specific folder. Check your browser’s
downloads settings to determine where the browser stored the backup file.

Opto 22 recommends that you apply some form of security on the backup file.

(Optional) To check which user files the backup may have missed, in groov Manage, click the menu
button (E), then select Info and Help. Click Logs > groov Manage.

groov RIO User's Guide



A

B———lb'[2020—04—l6 21:58:31.521] [INFO] ComponentBackupRestore -

CHAPTER 11: MAINTAINING A GROQV RIO

Review the log file for the list of user files that were and were not included in the backup file. Look for
lines like the following:

[2020-04-16 21:58:31.498] [INFO] ComponentBackupRestore -

Creating folder for User Files

[2020-04-16 21:58:31.503] [INFO] ComponentBackupRestore -
| Copying files for User Files

Copying /home/dev/secured/logo-rio-red-grey-569x197.png
[2020-04-16 21:58:31.538] [INFO] ComponentBackupRestore -
Copying /home/dev/secured/rio.txt

[2020-04-16 21:58:31.550] [INFO] ComponentBackupRestore -
Copying /home/dev/secured/temperature log-l.csv

A—These lines indicate that groov Manage started backing up user files.
B—This line indicates the first user file that groov Manage backed up.

8. Compare the list of files in the log with the list of files in the Internal Drive section of the Files page. (From

the groov Manage Home page, click System > Files.) Note any differences and download those files.

RESTORING A BACKUP OR SPECIFIC SETTINGS FROM A BACKUP FILE

Here are a few reasons you might want to restore all or part of a backup:

If you had to restore your processor to factory settings, a backup can help you quickly restore a
previously-saved configuration.

You might want to restore a prior configuration or a specific part of a prior configuration; for example,
only the firewall settings.

After you apply an update, restoring a backup can help you quickly restore a previously-saved
configuration.

When you want to restore a backup file, remember the following:

You can restore a subset of the settings stored in a backup file; for example, only the firewall and
accounts.

When you run the restore feature, the groov RIO shuts down all services and applications, restores the
projects and settings, and then restarts RIO. So, make sure to schedule the restoration during a time that
minimizes its impact on your applications and equipment.

The user IDs and passwords that are restored do not include any user IDs that you created after you
created the backup file. So, make sure you know the user ID and password of any administrator account
saved in the backup file so you can use that ID and password when you log into groov RIO.

To restore a backup file or specific part of a backup file:

1.

Locate the media or folder that contains the backup file and remove any security you may have applied
to the file.

On a computer or mobile device that contains the folder or is connected to the medium that contains
the backup file, log into your groov RIO with a user ID that has administrator privileges.

Click Maintenance > Restore.

In the Restore page, select or deselect the settings you want to restore. If you want to restore a particular
set of settings, leave the slider green (@l )). If you do not want to restore a particular set of settings,
move the slider to the left so that it shows gray ( ).

NOTE: Ifyou select a setting that doesn't contain any information in the backup, nothing will be restored for that
setting. This can happen if:
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When you created the backup, you deselected the setting.
- Youselect a setting (see below) that was not available in previous versions of the groov RIO firmware.

grOOVMANAGE =

€ Maint. Restore

Standard
1/O Configuration

Accounts

Networking

Firewall

Time

Node-RED
MQTT/Sparkplug
Client SSL Certificates

User Files
Existing user files will be deleted and replaced with any in the backup f

o

USB Settings

Advanced

Server S5L Certificates

& Upload Backup

Restoring a backup involves shutting down all services and applications,
restaring projects and settings, and then restarting the device.

5. Click Upload Backup.
6. Navigate to the folder or media device that contains your backup file.

7. Click Open. groov Manage displays the following message, reminding you of what groov RIO will do
during the restoration:

Restoring a backup involves shutting down all services and applications,
restoring projects and settings, and then restarting the device.

Do you want to continue with restoring the device?

Restore and Restart Cancel

8. (lick Restore and Restart. groov Manage displays a message that shows progress:

<Maint. | Restore

+ Upload progress
[

+ Decompress backup file

+ Check version
+ Upgrade backup file
+ Validate backup file

Stop applications and services

‘ s

Restore settings and projects

Restart device

EXicting user riles will be delated and replaced With
any in the backup file.
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9. When the restoration is done, groov Manage shows you this message:

Restore

<€ Maint. + Upload progress
[

+ Decompress backup file
+ Check version

+ Upgrade backup file

+ Validate backup file

+ Stop applications and services

+ Restore settings and projects

+ Restart device

any in the backup file.

Click Next.

10. groov Manage shows you a message that gives you a few tips about what you might need to do next.
Read the message and then click Close.

After the device restarts, you will need to sign in again. You

must use one of the accounts from the backup that was just
restored.

Networking settings may have also changed, like hostname and
IP address. You may use the device's screen to review the
settings.
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11.

12.

13.

groov RIO restarts. Wait for the groov RIO login screen and log back in with any user ID that has
administrator authority and was stored in the backup file.

Review the configuration settings for things like I/0, date and time, and netwaork, to assess whether you
need to make additional changes that were not stored in the backup file.

Because the backup files contain only the first 10 MB of user files, if there were any additional files that
weren't included in those 10 MB, upload them.

UPDATING FIRMWARE ON A groov RIO

Updating firmware on a groov RIO keeps it up-to-date with the latest features and fixes. Updating firmware
can take 20-30 minutes or more to complete and your groov RIO will be restarted, so schedule the update
during a time when it minimizes impact to your automation processes and equipment. Remember that if you
have several RIOs daisy-chained together, if you updated the firmware on one RIO, you must update the
firmware on all the RIOs in the chain.

96

1.

If you haven't done so recently, create a backup file (see “Backing up Your groov RIO Settings”on
page 91). Keep this file handy and secure.

Note: groov Manage provides you the option to automatically create a backup before it installs the firmware.
However, if you have an excess of 10 MB of user files, or you don't want certain settings saved in the backup,
create a backup.

Log on to opto22.com and enter the part number for your groov RIO in the Search box. Select the search
result that includes “Firmware” as part of the title; for example GRV-R7-MM1001-10 Firmware.

Click Download. Save the file to either:
— A computer or mobile device that can connect to your groov RIO, or
- Media that you can then install to a computer or mobile device that can connect to your groov RIO.

On the same computer or mobile device where you saved the firmware file, log into your groov RIO with
a user ID that has administrator privileges.

From the groov Manage Home page, click Maintenance > Update.
On the Update page, decide:

- If you want to save all your current settings and then have the groov RIO restore them after the
restart, leave the Back Up Settings slider in the default position (the slider shows green). Leaving this
setting on will also save you some steps later on.

Ifyou created a backup file in step 1, note that the information in that backup file may not be the same as what
groov Manage stores in the backup it creates as part of this step.

- Ifyoudonot want the settings saved and restored after the restart, move the slider to the left so that
it shows gray ( ). You'll want to select this if you want to restore your groov RIO with settings
from a different backup file; for example, the one you created in step 1.

grooVMANAGE =

£ Maint. Update

Sign into manage.groov.com to get the latest groovRIO system update.

WARNING: Applying a system update will elearyour uploaded files and
Node-RED praject. You must back up your system prior to applying the
update.

Current Firmware 2.0.0-b.12+beta
Build Date 2/19/2020
Back Up Settings (

Back up settings and automatically restore after the update.

X, Update System
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7. (lick Update System.
8. Navigate to the software update file you downloaded in step 3.
9. Click Open.

groov Manage displays a message to remind you that the update clears all your settings and projects, and
gives you one more opportunity to cancel and perform that important backup.

The update will take several minutes to complete. DO NOT power off
your groovsystem during an update. Please wait for your system to
Fully restart.

WARNING: Applying a system update will elear your uploaded files
and Node-RED project. You must back up your system prior to
applying the update.

Do you want ko perform a system update?

Update and Restart  Cancel

10. If you are ready to proceed with the update, click Update and Restart.

groov Manage displays an Update message, which shows you the progress of the update. The update can
take several minutes to complete. During that time, the banner (in the background) changes color to
yellow.

i Update |

< Maint. + Upload progress
[ |

+ Unzip image

i.: Verify and decrypt image
Format partition
Decompress update
Back up settings
Install update
Restart device

Da not power off the device or leave this page while the update is in progress.

groov RIO User's Guide 97



UPDATING FIRMWARE ON A GROOV RIO

11. Watch for the banner to turn red, which indicates that the update is finished and groov RIO is now offline.
Review the messages and then click Next.

Update

£ Maint. + Upload pragress
[

+ Unzip image

+ Verify and decrypt image
+ Format partition

+ Decompress update

+ Back up settings

+ Install update

+ Restart device

Da not power off the device or leave this page while the update is in progress.

12. Read the instructions on what to do after groov RIO restarts, and then click Close.

The device will restart and restore the settings that were backed up.

Networking settings may have changed, like hostname and IP address.

13. If you can see the groov RIO unit, monitor the STAT LED. When it shows solid green, the restart is finished
and the browser refreshes. If you can't see the RIO unit, you will know that the restart is done when the
browser refreshes.

Note: If the browser doesn't refresh after about 5 minutes, refresh it by pressing £5 or CTRL+R.
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14. When the restart is done, you see one of the following screens.

Welcome screen Login screen

Welcome!

Username

RIO

Password

Let's get started! ©

#Sign In

Hostname

Eth0 IP Address

If you see the Welcome! screen (you'll see this screen if you deselected the Back Up Settings option in
step 6 on page 96):
a. Make a note of the IP address shown in the EthO [P Address box. You'll need it in the next few steps.

b. Click Let's get started! and create an administrator user ID and password. (It does not have to match
any that might be stored in a backup file; however, you still do have to remember to store it in a safe
location for later recall.)

¢. Clickon Configure Device.
d. [fyou want to restore a backup file, do that now.

If you see the login screen (you'll see this screen if you selected the Back Up Settings option in step 6
on page 96), log into your groov RIO with a user ID that has administrator privileges.

If you see neither screen (likely because your network settings were not backed up as part of the
update), use groov Find to get the IP address or hostname of the unit. See “Downloading and Running
groov Find"on page 100.

15. If you were developing and running Node-RED flows, re-install any nodes required by your flows. For
example, to re-install the Opto 22 nodes:

a. (lickthe menu button (E) > Manage palette > Install tab.

b. Searchfor node-red-contrib-pac.

¢. (lick the small Install button.

Repeat the previous steps for any other nodes required by your flows.

If you do not re-install these nodes and you try to run your flows, you'll receive messages that your flows
cannot run due to missing nodes.

TROUBLESHOOTING

Browser Reports that URL to RIO is Unreachable

There are several reasons that a browser may report that it cannot connect to your RIO through its hostname;
some of those reasons may be physical connectivity issues, some may be network configuration issues. Here
are a few things to check:
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Verify that the Ethernet cable that you inserted into the RIO’s Ethernet port is connected to the network.

Make sure the STAT LED is solid green before you attempt to connect to your RIO. (For a diagram that
shows you where the STAT LED is located, see page 8.)

Check that the LED of the Ethernet port (ETHO or ETH1) is showing link speed and activity. (For an
explanation of LED activity, see page 8.)

If the RIO is connected to a network that does not automatically assign IP addresses to new devices
(which typically means the network is not managed by a DHCP server), download groov Find to help you
locate your groov RIO on your network (see below). You must use groov Find if your network does not
have DNS.

Downloading and Running groov Find

groov Find is an application available on our website (for Windows PCs) or the Mac App Store (for Mac
computers) that can help locate groov RIOs, groov EPICs, and groov Boxes on your network.

Instructions for PC Users:

1.

Download groov Find from our website (go to www.opto22.com and enter groov Find in the search
box). Save the file to your computer.

Open the Find application file.

If you have User Account Control (UAC) turned on, a message appears asking if you want groov Find to be
allowed to make changes to your computer.

®) User Account Control x

Do you want to allow this app from an unknown
publisher to make changes to your PC?

Program name:  groovFind.exe

Publisher: Unknown
File crigin: Hard drive on this computer
() Show details Yes

Change when these notifications appear

NOTE 1:If you are using a Windows account that does not have Administrator privileges (such as Guest), you
will need to enter the Administrator User Name and Password in order to use groov find. If you do not have this
information, contact your IT department.

NOTE 2: Clicking Yes permits Find to have temporary administrative privileges to create an additional temporary
IP address for each network interface on the computer. This enables Find to locate a groov device on a network
that does not have DNS and DHCP If the network does not have DNS and DHCP, you will need to assign a static
IP address to the groov device in order to maintain communication. If the network does have DNS and DHCP
the temporary IP address is not used and is removed when you exit Find.

Click Yes.

groov Find opens and automatically searches for groov RIOs, groov EPICs, and groov Boxes on the
network.

Locate the serial number on the groov device.

- Ongroov EPIC, open the LCD display and look at the label on the back of the display.

- Onagroov Box, find the label on the bottom of the Box.

- Onagroov RIO unit, the label is on the unit’s side. The serial number is indicated by SN.
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Locate the matching serial number in Find.

groov Find OPTO 22

Use the Search For Devices button to find all of the groov Devices that this computer can access.

Search For Devices

Find the serial number of your groov Device and select one of its links.

Device Type Serial Hostname IP Address Open in browser..
Number
GROOV-AT1 - opto- groovAdmin | groov View
‘GROOV-AR1 . =u opto- groovAdmin | groov View
GROOV-AR1 o e 28 [T groov Admin | groov View
GROOV-AT1 - opto-7] = Click to start groov
GRV-R7- opto Ck tO Stait groc
MM1001-10 Manage
GRV-R7- opto- Click to start groov
MM1001-10 Manage
GRV-EPIC-PR1 ! Click to start groov
Manage
GRV-R7- optos=r= Click to start groov
MM1001-10 Manage
GRV-R7- RIOH Click to start groov
MM1001-10 Manage
GRV-R7- = rio- Click to start groov
MM1001-10 | Manage

Note: If your device was nntﬁlund, wait 60 seconds and try again. more info

Serial number

If you do not see the serial number right away, wait 60 seconds and click Search For Devices.
Click the link for groov Manage.

Instructions for Macs:

1.

Locate the serial number on the groov device.

- Ongroov EPIC, open the LCD display and look at the label on the back of the display.

- Onagroov Box, find the label on the bottom of the Box.

- OnagroovRIO, the label is on the unit's side. The serial number is indicated by SN.

On your Mac, go to the Mac App Store.

- (lick on the apple menu (top left corner), then select App Store.

- Click on Finder, then click Applications, then find and click App Store.

In the store, enter Opto 22 in the search box.

Click “Get"on the groov Find app. If requested, enter your Apple Store ID and password.

Click Open to start the groov Find app. Within a few moments, groov Find begins locating groov RIOs,
groov EPICs, and groov Boxes on your network and displays them in a list.

Under the Serial Number column, locate the serial number of your groov device and select it.

At the bottom of the window, click either Open groov View or Open groov Manage. Your default browser
will open up with the groov device's IP address in the URL bar, and then load either groov View or
groov Manage.

CODESYS: “Invalid Channel Type. Module or channel may not be compatible.”

There are certain combinations of signal types that aren’t supported on GRV-R7-MM1001-10. CODESYS does
not prevent you from creating these combinations, so you might not know you created one until you try to
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download your project. When this happens, you'll see the following messages on the channels that are
incorrectly configured:

# RIO Project with Build 31.project - CODESYS.
File Edit View Project Build Online Debug Tools Window Help

=== =] [ [T | ¥4  Application [Device: PLC Logic] ~ oy "I s |9 |=
Devices - 2 x Device. [ Ethernet El GRv_R7_MM1001_10 Al GROOV_CHANNEL_1 X
=3 RIO Project with Buitd 31 -
E Device [connectsd] (GRV-EPIC-PR1) b : Module reparts an error
=B PLC Logic
Y /0 Mapping Last DiagnosticMessage
i Lirary Manager IEC Objects Disgnostic ‘Invalid channel type. Madule ar channel may not be compatible.
PLC_PRG {PRG)
= (B Task Configuration Status
=358 MainTask
) pLe_FRG Information

(] Ethernet (Ethemnet)
= [l GRV_R7_MM1001_10 (GRV-R7-MM1001-10)
M5 GROOV_CHANNEL (Analog In Type J Thermocouple (°CJ) H
e The message that CODESYS displays.
K <Empty2>
£ <Empty3»
£ <Emptya>

A GRV-R7-MM1001-10 with an unsupported combination
of signal types on channels 0 & 1.

To correct this problem, move the problematic signal type to a channel further away. In this example, we
move the digital sinking output from channel 1 to channel 7:

=5 RIO Arojiect with Buid 31 -
=+ Device [connected] (GRV-EPIC-PR 1)
=-E pLC Logic
= [} Application [run]
il Library Manager
PLC_PRG [PRG)
= (& Task Configuration
= mainTask
& PLC_PRG
=3 (] Ethernet (Ethernet)
=+ GRV_R7_MM1001_10 (GRV-R7-MM1001-10)
HES GROOV_CHANNEL (Analog In Type J Thermocouple (°CJ)
<Empty1>
<Empty2>
<Empty3>
<Empty4>
<Empty5>
<EmptyG>
HJS GROOV_CHANNEL _1 (Digital Out 5-30 VDC)
K <Emptys>
K <Emptyas

RAaRnRAR

RESETTING TO FACTORY DEFAULTS

You might have to reset to factory defaults if instructed to do so by product support. A reset to factory defaults
erases all the changes you made to the groov RIO, which is why it is important that you regularly back up your
system. (For instructions, see “Backing up Your groov RIO Settings”on page 91))

Insert a paper clip into the RST hole and push down for approximately 8 seconds. Release the button when
the STAT LED alternates between red and green.
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Insert paper clip into
RST hole and hold it
down for 8 seconds.
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COLLECTING INFORMATION FOR PRODUCT SUPPORT

The groov RIO collects information in several logs that can help Product Support diagnose and solve issues.
Product Support will direct you with the specific information to collect. You might want to create a new folder
on your computer or mobile device with the name of the Opto 22 ticket number, if you have one, and store all
this information into that folder.

If you need to collect information from the screens, you can use the screen capture feature on the computer or
mobile device to save (capture) the screens.

If Product Support directs you to send log files, do the following steps:

1.  Onacomputer or mobile device, log into the groov RIO with a user ID that has administrator privileges.
Click Info and Help.

Click Logs.

Click on the specific log or logs as directed by Product Support.

Click Download.

o v s wWwN

Navigate to a folder on your computer or mobile device where you want to save the log. You might also
want to make note of the name of the log file or modify it to something else.

7. Click Save.
8. Repeat steps 4 through 7 for all the logs that Product Support directs you to download.

Send this information to Opto 22 as directed by Product Support.

CONDUCTING AN OPTOSUPPORT REMOTE SUPPORT SERVICE (RSS) SESSION

An OptoSupport Remote Support Service (RSS) session can help expedite the resolution of your support ticket
by allowing the OptoSupport team member to remotely connect to your groov RIO to continue with
diagnostics and troubleshooting.

After evaluating the progress of your ticket, your Opto 22 Support team member might determine that your
situation would benefit from an RSS session and discuss with you the benefits and goals of the session. If you
agree with this step, our team member will schedule a time to start a Remote Support Service (RSS) session.

Before beginning the session, make sure your groov RIO is on a network with access to the Internet.

An RSS session typically runs like this:
1. Atatime agreed upon by you and your OptoSupport team member, you'll initiate a phone call.

groov RIO User's Guide 103



CONDUCTING AN OPTOSUPPORT REMOTE SUPPORT SERVICE (RSS) SESSION

104

When instructed, click Create RSC to initiate the session. For detailed instructions and an explanation of

what happens during this step, see “Initiating an RSS Session”on page 104.

After the session is successfully created, you and your OptoSupport team member will review details of

your situation and discuss additional steps. These steps might be:

- Continue active discussion of the problem over the phone while the OptoSupport team member
diagnosis and troubleshoots your groov RIO.

- Agree to a plan of action where you can end the phone call while the OptoSupport team member
continues to diagnose and troubleshoot your RIO.

If the session is lengthy, part of the plan might include pausing the session and continuing it at a later

time. For additional instructions on pausing and resuming a session, see “Pausing and Resuming an RSS

Session"on page 105.

When it's time to end the RSS session, click Delete RSC. For important information on what happens

when you end an RSS session, see “Ending the RSS Session”on page 106

Initiating an RSS Session

1.

5.

The Opto 22 Support team member will ask you to navigate to the OptoSupport RSS page, if you haven't
already done so. (From the groov Manage home page, click or tap Info and Help > OptoSupport RSS.)
The Opto 22 Support team member will ask for the serial number listed on the OptoSupport RSS page.
This information is necessary for the connection to be successful.

AL the end of the RSS session, the support engineer asks you to
delete the RSC. Once the RSC is deleted, the associated
credentials can never again be used to connect to your device.

Status Disconnected

P Create RSC
Serial Number D

When instructed by the Opto 22 Support team member, click Create RSC.
The first thing you see is the OptoSupport Remote Support Service Permission and Release Agreement.
To proceed with the session, accept the agreement.

After you click Accept, groov Manage displays a message to indicate the progress of establishing the
connection before it starts a connection:

e |

| Create Remote Secure Connection

« Check outbound connection
i.: Prepare PSG package
Upload PSG package
Begin VPN connection

Finish

Close

When it finishes these steps, click OK to close the message box:
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__| Create Remote Secure Connection

+ Check outbound connection
« Prepare PSC package

+ Upload PSG package

+ Begin VPN connection

« Finish

Once connected, the support engineer has access to all information stored in
vour device_ includina (but not limited ta) anv nroiects vou've created.

- While your groov RIO is trying to connect, you see this message on the OptoSupport RSS page:

Status Connecting ko Opto Support

M Delete RSC

—  After the connection is established, you see this message on the OptoSupport RSS page:

Status Connected

1 Pause RSC

W Delete RSC

Do not turn off your groov RIO after you start the session, or you will need to start this process over.

Pausing and Resuming an RSS Session

During the course of diagnosis and troubleshooting, you and your OptoSupport team member might agree to
pause the session, then resume it at a later time. Pausing the session prevents communication between
OptoSupport team member and your groov RIO while preserving the information needed to quickly resume
the connection.

To pause a session, click Pause in the OptoSupport RSS page (Info and Help > OptoSupport RSS).
groov Manage displays a message confirming the pause. Click OK to close the message. The OptoSupport
RSS page updates the status to indicate the RSS session is paused:

Status Connection paused

P Continue RSC

M Delete RSC

To resume a session, click Continue RSC in the OptoSupport RSS page (Info and Help > OptoSupport
RSS). After the connection is re-established, the OptoSupport RSS page displays the status as Connected.

Status Connected

1 Pause RSC

W Delete RSC
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Ending the RSS Session

When it's time to end the RSS session, click Delete RSC in the OptoSupport RSS page (Info and Help >
OptoSupport RSS). All of the information that your groov RIO created to establish the connection will be
erased. If you need to start another RSS session, you'll need to start from the first step in “Initiating an RSS
Session”on page 104.
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A: Specifications

GRV-R7-MM1001-10

You can configure the GRV-R7-MM1001-10 (a multi-signal, multifunction edge I/0 unit) with any combination
of the following inputs and outputs:

+  Upto2electromechanical relays
«  Acombination of up to 8:

- discrete or analog inputs

- discrete or analog outputs

Features are listed on the next page; specifications are listed in the page that follows.
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Features
DI: Dl: DO: DO: Al: Al: AO:
« Discrete * Discrete » DC Sinking |+ Form C » Voltage [+ Current + Voltage
+ Switch Input, | * Switch Input, Mech. Relay |+ ICTD » Thermocouple |+ Current
Powered Powered * Millivolt
Channels
Features
On/off State X X X X
On/off Latching X
Counting X
On/off Totalization X
Frequency Measurement X
Period Measurement X
Pulse Measurement X
Scaling X X X
Offset and Gain X X
Minimum/Maximum Values X X
Average Filter Weight X X
Simple Moving Average
Analog Totalizing X X
Output Pulsing / TPO X
Ramping X
Clamping X
Watchdog Timeout Value X X X
Quality Indication X X X
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Specifications

Specification GRV-R7-MM1001-10

Voltage Input

Available Channels 0-7

Input Range 0-10v DC

Over-range Limit 0-11 Vv DC

Resolution 0.5 mV

Accuracy +0.05% of range (+5 mV)
Gain Temperature Coefficient 30 ppm/°C

Offset Temperature Coefficient 15 ppm/°C

Input Impedance > 425 kOhms

Data Refresh Time 450 ms

50 / 60 Hz rejection >90dB

Current Input

Available Channels 0-3

Input Range 0-20 mA

Over-range Limit 20.8 mA

Recommended Fuse 32-40 mA, Fast Acting (for example, Eaton S500-32-R)
Resolution 1.0 pA

Accuracy +0.05% (£10 pA)

Gain Temperature Coefficient 30 ppm/°C

Offset Temperature Coefficient 15 ppm/°C

Input Voltage Drop (+10%) 09V@4mA 20V@20mA, 25°C
Equivalent Input Impedance (£10%) 225 Ohms @ 4 mA, 100 Ohms @ 20 mA, 25 °C
Data Refresh Time 450 ms

50 / 60 Hz rejection >90dB

Available Channels 0-7

Input Range with ICTD Probe -40 to +100 °C

Resolution 0.04 °C

Accuracy with ICTD Probe +1.0 °C (1.8 °F)

Gain Temperature Coefficient 30 ppm/°C

Offset Temperature Coefficient 60 ppm/°C

Data Refresh Time 450 ms

50 / 60 Hz rejection >90 dB
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Specification GRV-R7-MM1001-10

Thermocouple Input

Available Channels 0-3*

Nominal Input Range -75 to +75 mV

Full Scale Range -78 to +78 mV

Input Resolution 3 microvolts

Input Impedance > 1 megohm

Data Refresh Time 450 ms all channels
50 / 60 Hz rejection >90dB
Thermocouple ITS90 Types * Accuracy / Resolution
B 90°C to 1,820°C 7°C/ 04°C
E: -80°C to 1,000 °C 2°C/ 0.1°C
J: -100°C to 1,200 °C 2°C/ 0.41°C
K: -80°C to 1,372°C 2°C/ 0.1°C
N: -100°C to 1,300 °C 3°C/ 0.1°C
R: 100°C to 1,768 °C 6°C/ 0.3°C
S: 100°C to 1,768 °C 6°C/ 0.3°C
T: -60°C to 400°C 3°C/ 0.1°C

* Note: To achieve the best thermocouple accuracy when also using current outputs or discrete outputs, always configure thermocouples
on the lowest channel numbers and outputs on the highest channel numbers.

Available Channels 0-3

Input Range -150 to +150 mV
Over-range Limits +165.0 mV

Resolution 10 pv

Accuracy +0.1% of Range (£150 pV)
Input Impedance >1 MOhms

Data Refresh Time 450 ms

50 / 60 Hz rejection >90dB

Discrete DC Input

Available Channels 0-7

Input Voltage Range 5-30 v DC
Minimum ON Voltage 50V
Maximum OFF Voltage 1.5V

Input Impedance > 425 KOhms
Max. Input Frequency (50% square wave) 10000 Hz
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Specification

Switch Input, Powered

APPENDIX A: SPECIFICATIONS

GRV-R7-MM1001-10

Available Channels

Open Circuit Voltage (Switch Open)

Channel Current Limit

Channel Operating Current

Minimum Off Resistance

Maximum On Resistance

Minimum ON Voltage

Maximum OFF Voltage

Maximum Continuous Survivable Input Voltage
Input Impedance

Max. Freq. (50% square wave)

Discrete Counter Input

0-7

10.5 V (minimum)
1.1 mA max.
0.63 mA typical
3300 Ohms
1200 Ohms
5V

15V

32V

> 425 KOhms
10000 Hz

Available Channels
Input Voltage Range
'ON' Threshold
'OFF' Threshold
Input Impedance

Max. Frequency (50% square wave):
State, Latches, Counter

Max. Frequency (50% square wave):
On/Off pulse width, Period, Frequency

Max. Frequency (50% square wave):
On/Off totalization

Pulse Width Measurement Resolution

Pulse Width Measurement Error
(50% square wave)

Period/Frequency Error
(50% square wave)

0-1
5-30VDC
5V

1.5V

> 425 KOhms

10000 Hz

2000 Hz

750 Hz

100 microseconds

0.1% 0 to 20 Hz.
1% 21 to 200 Hz.
5% 201 to 2000 Hz.

0.05% 0 to 20 Hz.
0.1% 21 to 200 Hz.
1% 201 to 2000 Hz.

Discrete DC Sinking Output

Available Channels

Line Voltage Range

Maximum Continuous Current

Peak Current (< 10 ms)
Recommended Fuse / Circuit Breaker
Output Voltage Drop

Off-State Leakage (per channel)
Peak Blocking Voltage

TPO Period (min, max, resolution)
Turn On / Off Time

0-7 (4-7 if using any thermocouple inputs)
5-30V DC

1.0A

40A

1Aat30VDC

175 mV at1A

<80 pAat24V, -20to +70 °C

32V

0.004, 4294967, 0.001

20 ms nominal.
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Specification

Form C Relay Output

GRV-R7-MM1001-10

Available Channels

Line Voltage Range

Clamp Voltage

Current Rating

Surge Current

Recommended Fuse / Circuit Breaker
Initial Contact Resistance

Turn On Time

Turn Off Time

Operating Life (to specification)
Mechanical Life

Voltage Output

8,9

0-250 VAC or 5-30 V DC

440 V nominal

5 A per channel

6 A peak for 1 second

5Aat250 VAC /> 30V DC per channel
< 100 milliohms

8 ms

4 ms

Min. 30,000 cycles at max. ratings

Min. 10,000,000 cycles

Available Channels

Range

Resolution

Accuracy

Gain Temperature Coefficient
Offset Temperature Coefficient
Output Slew Rate

Minimum Load Resistance
Output Impedance
Short-circuit Current

Data Refresh Time

Current Output

4-7

0-10V

2.5mV

1+0.2% of range (20 mV)
50 ppm/°C

20 ppm/°C

>15V/ms

7.5 kOhms

<10 Ohms

20 mA

Nominal 20 ms. Proportional to I/O scan time.

Available Channels

Output Range

Resolution

Accuracy

Gain Temperature Coefficient
Output Slew Rate

Maximum Loop Resistance

Data Refresh Time
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5 uA

10.25% of range (+50 pA)
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Specification

Common Specifications

APPENDIX A: SPECIFICATIONS

GRV-R7-MM1001-10

Two switched Gigabit ports; daisy-chainable; ETH1 with 802.3af PoE powered

Ethernet device (PD)

USB One Port, USB 2.0 HS

Memory 1 GB RAM, 2.5 GB user space
Power Supply 802.3af PoE Class 0 or 10-32 V DC
Power Consumption 10W

Max. Survivable Input (channels 0 - 7) 32V DC

Isolation (between channels 0 - 7) None

Isolation (between channel 8 or 9 and all others)

Isolation (field to Ethernet / power input)

3000 V AC,,, 1 min.
1500 V AC,,, 1 min.

Minimum GRV-EPIC-PR1 Firmware Version 2.0.0

Minimum PAC Project Version 10.3000

Minimum Library Package for CODESYS Version 2.0.0.0

Field Connector Wire Size 28-14 AWG
Torque, field connector screw 2.5in-Ib (0.28 N-m)
Power Connector Wire Size 22-14 AWG

Torque, DC power connector screws
Torque, panel mount tab screw
Temperature (operating)
Temperature (storage)

Relative Humidity (non-condensing)
Agency Approvals

Warranty

7.0 in-b (0.79 N-m)

2.0 in-Ib (0.23 N-m)

-20 °C to +70 °C

-40 °C to +85 °C

5-95%

UL/cUL(Class 1 Div. 2); CE, ATEX(Category 3, Zone 2), RoHS; DFARS; CB Scheme
30 months

Wiring Assignments

These assignments apply to the thermocouple input signal type.

Type - + Range
B Red Gray +90 °C to +1,820°C
E Red Purple -80 °C to +1,000°C
J Red White -100 °C to +1,200°C
K Red Yellow -80 °C to +1,372°C
N Red Orange -100 °C to +1,300°C
R,S Red Black 100 °C to +1,768°C
T Red Blue -60 °C to +400°C
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B: Wiring Diagrams

WIRING FIELD DEVICES

Diagrams are readily available to help you wire field devices to groov RIO.

«  Basic wiring diagrams are shown on the following page for all channels. Note instructions on fusing and
power.

«  You can also find wiring diagrams for each channel type in groov Manage. At the groov Manage
homepage, choose I/0 Reference > groov RIO Mixed Signal, Multifunction > [RIO part number] and
select the signal type to see how to wire it.

groov RIO Explorer

The groov RIO Explorer is an online, interactive tool that can help you select and track which combinations of
functions (input or output) and signal types (analog, discrete, voltage, current, ICTD, thermocouple, etc.) you
can assign to specific channels.

For instructions on how to use it, see Appendix C: groov RIO Explorer on page 117.
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Channel

Cho

Ch1

Ch3

Ch4

Chs

Ché

Ch7

Chs

Internal Pin
Wiring m
. .

Discrete

Discrete Powered

Switch Input,

Voltage I

‘ ICTD

Thermocouple/
Millivolt

Discrete
DC Sinking

OUTPUT

Analog
Current / Voltage

Mechanical Relay
Form C-NO "Form C-NC

Notes:

1.
2.

You must supply external fusing.

Opto 22 recommends adding external fusing. Review the specification table for specific ratings. Compatible with an externally powered or self
powered transmitter. Wiring for externally powered transmitter is shown on channels 0 and 1. Wiring for a self powered transmitter is shown on

channels 2 and 3.

Thermocouple inputs and discrete sinking outputs cannot be mixed on channels 0-3.
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C: groov RIO Explorer

The groov RIO Explorer is an online app that helps you see different combinations and arrangements of
channel configurations and their associated wiring diagrams. With the app, you can:

« Identify which channels support a specific combination of function (input or output) and signal type
(analog, discrete, voltage, current, ICTD, thermocouple, etc.).

«  Move any signal that you placed on one channel to another supported channel.

«  Avoid assigning a combination of function and signal type to a channel that does not support that
particular combination.

«  See a wiring diagram of the combination you built, plus different ways to arrange that combination.
«  Export orimport a combination into text description.
«  See samples of wiring configurations from over 61,000 possible combinations.
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THE GROOV RIO EXPLORER

THE groov RIO EXPLORER

Open the

online app by opening a browser and going to www.opto22.com/products/groov-RIO-Explorer.

Here's an overview of what you can see and do in the window:

| D

groov RIO® model GRV-R7-MM1001-10

Explore signal connections

About groov RIO

Input Signals

Click to highlight
supported signals  Placd signals
~

- APLACE | FIND CHANNELS | Voltage input -2
@ PLACE | FIND CHANNELS [ Current input =
@ PLACE | FIND CHANNELS Jp ICTD =
2 PLACE | FIND CHANNELS [ Thermocauple > A
@ APLACE | FIND CHANNELS [ Millivolt input -
@ C (PLACE | FIND CHANNELS | Discrete input =
@ PLACE | FIND CHANNELS P é:::;:;wa‘e nput (with —.
@ 4PLACE | FIND CHANNELS | Switch input (powered) ==
5
PLACE | FIND CHANNELS [ Current output —
4PLACE | FIND CHANNELS |p»Voltage output ]
@ PLACE | FIND CHANNELS [»DC sinking output i
APLACE | FIND CHANNELS |Form C, normally open = B

| E 4PLACE FIND CHANNELS ’Form C. normally closed —

G H \ » Import and Export
F _— »> Samples (and some funl)

= I® Tmo OwW>

Now let’s

Signal types available for inputs.

Signal types available for outputs.

When you place a signal, it's shown in this column, next to the channel you selected or the first
channel number that supports that signal.

To view specifications for the signal type, click the triangle next to it.

To access import and export functions, click the triangle to open this section.

To see sample configurations and different arrangements for your own or sample configurations, click
the triangle.

To download your wiring diagram as a Scalable Vector Graphic, click Download image as SVG file.
To remove all the signals you placed on the RIO Explorer and start over, click Clear signals.

To see specifications for this groov RIO unit, click the triangle.

see how to assign channels to match the configuration you want.
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APPENDIX C: GROOV RIO EXPLORER

Assigning Functions and Signals to a Channel

Follow the steps below to assign a function (input or output) and signal type to a channel.

groov RIO® model GRV-R7-MM1001-10

Explore signal connections | Show wiring e

1.

»  About groovRIO

v Input Signals

Cliek to nignlight
sugporied signals  Flacad signals
~

4PLACE FIND CHANNELS ’ Voltage input )
4PLACE | FIND CHANNELS |pw Current input o
4PLACE FIND CHANNELS ’ ICTD =
4PLACE FIND CHANNELS ’ Thermocouple ™

&

e PLACE | FIND CHANNELS [ Milivolt input

APLACE | FIND CHANNELS | Discrete input ¥

Smart discrete input (with __,

4PLACE FIND CHANNELS ’Emwes)

H
1
2
s
.
5
s
7
s
°

PLACE | FIND CHANNELS [ Switch input (powered) ==

¥ Output Signals

4PLACE FIND CHANNELS ’Current output -]

PLACE | FIND CHANNELS [pVoltage output —

e 4PLACE FIND CHANNELS ’DCsinking output ik o

PEROEPEEEE @

Dovnload image as SVGfile | Clear signals APLACE | FIND CHANNELS |p»-Form C, nommally open ="

4PLACE | FIND CHANNELS [p»-Form C, normally closed —»=

[ 2 Import and Export

B Samples (and some funf)

Look through the options on the right. Look in either the input or the output list and choose the signal
type you need.

For example, if you need an ICTD input, look in the Input Signals list and find ICTD.

If you need a voltage output, look in the Output Signals list and find Voltage Output.

Click Place next to the function and signal type you need.

The Explorer places that function and signal on a channel that supports that combination. For example,
your ICTD input might appear like this:

groov RIO® model GRV-R7-MM1001-10

Click to highlight
supported signals  Places signals
~

»> About groov RIO

¥ Input Signals

4PLACE | FIND CHANNELS | Voltage input ®
PLACE | FIND CHANNELS | Current input =
| 4PLACE | FINDCHANNELS P ICTD =
PLACE | FIND CHANNELS [P Thermocouple =
PLACE | FIND CHANNELS | Millivot input =

4PLACE | FIND CHANNELS |p» Discrete input

Smart discrete input (with

4PLACE | FIND CHANNELS ’fealnres)

4PLACE | FIND CHANNELS |pw Switch input (powered) ==

+ GO v Qutput Signals
prede.

(Temperature)

PERREOEEE G4

4PLACE FIND CHANNELS ’Currenl output -]
4PLACE | FIND CHANNELS |[pwVoltage output ]
4PLACE FIND CHANNELS ’D‘T sinking output

If you don't like where the Explorer placed your signal, see “Moving and Deleting Signals”on page 120.
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3. Repeat the previous steps for each additional channel you want to configure.

The Explorer will not let you place functions and signals into channels that don't support them.

4. (lick Show wiring to see a diagram that illustrates wiring for all your selections.

Below are three examples of images of wiring diagrams created by the groov RIO Explorer for function and
signal type assignments made to channels on a GRV-R7-MM1001-10.

Channels Pins Channels Pins Channels Pins
& -
Millivolt Voltage Voltage
0 @ Input 0 9 Input 0 e Input
ﬂ +
[} [4]
& 1 Current Voltage Voltage
t + Input 1 e Input i e Input
A
Current Voltage _
2 + Input 2 e Input 2 g Thermocouple
N : +
Black +
9 ful White ICTD 3 s Thermocouple & » Thermocouple
+ +
4 B +  Discrete 4 Voltage 4 ol +  Discrete
Input a Input Input
15 15]
5 . +  Discrete 5 Voltage 5 : +  Voltage
E Input @ et 1o Output
6 b Switch 6 + 6 +  Voltage
Input ICTD Output
(powered) White
Y -+ Current 7 +  Discrete 7 +  Voltage
Output Input OQutput
L3 Form C NG Form C Form G
8 o COM  Normally 8 3 COM  Normally 8 N COM  Normally
NO Open Closed NO Open
L3 NC Form C 3 NC Form C C3 Form C
9 v COM  Normally 9 v COM  Normally 9 COM  Normally
Closed Closed NO Open

5. If you want to save your wiring diagram as a re-sizable image file, click Download image as SVG file.
To leave the wiring diagram, click Explore signal connections.

Moving and Deleting Signals

»  Tomove asignal, click on the placed signal. R
Click the up or down arrow to move the SupporgRnle  Pleesgenat
signal to another available channel that e
supports that signal. (The Explorer can

(]
“hop” over assigned channels, if necessary.) Eﬁ
«  Todelete the signal, click a placed signal ia ®A
: ar "4 Dicet
and then click Remove. : b
2 ma Remove
j oy
C 1t
[ 0 (on/of) |

Viewing Possible Signals and Channels

To see which functions and signals you can place on a channel, click the channel number. The RIO
Explorer highlights all the functions and signal types that you can assign to that channel.

In the example that follows, when you click the number for channel 5, the RIO Explorer highlights Voltage
input, ICTD, Discrete input, and Switch input (powered) under the Input Signals section; Current output,
Voltage output, and DC sinking output under the Output Signals section. You can assign any of those to
channel 5.
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groov RIO® model GRV-R7-MM1001-10
| Explore signal connections | Show wiring | >

v Input Signals

About groov RIO

Clisk to Pighiight
supporied signals  Flaced signals
~

b «PLACE | FIND CHANNELS [ Voltage input e
@ 4PLACE | FIND CHANNELS |p» Current input oy §
@ 4PLACE FIND CHANNELS ’ICTD e
® 4PLACE FIND CHANNELS ’ Thermacouple T
@ 4PLACE FIND CHANNELS ’ Millivelt input )
@ 4PLACE | FIND CHANNELS ’ Discrete input =

Smart discrete input (with __,

4PLACE FIND CHANNELS ’Emwes)

i

PLACE | FIND CHANNELS - Switch Input (powered) ==

¥ Output Signals

@EEE

PLACE | FIND CHANNELS [p»Curent output —
PLACE | FIND CHANNELS [p-Voltage output —
PLACE | FIND CHANNELS [-DC sinking output oy
PLACE | FIND CHANNELS »Form C, normally open
4PLACE | FIND CHANNELS |p»Form C, normally closed —

To see which channels can be configured with a specific function and signal, find the function and
signal in the lists at right. Click the FIND CHANNELS button, and the Explorer highlights the channels that
support that combination.

For example, if you want to see which channels will accept a smart discrete input with features like counting,
latching, and totalization, click its Find Channels button. Channels 0 and 1 are highlighted, so you can place
that signal on either (or both) of those channels.

groov RIO® model GRV-R7-MM1001-10

Click to highlight
supported signals  Placed signals
~

B Aboutgroov RIO

v Input Signals.

4PLACE | FIND CHANNELS [p» Voltage input =c)
4PLACE | FIND CHANNELS | Current input oy
4PLACE | FIND CHANNELS P ICTD -]
4PLACE FIND CHANNELS ’ Thermocouple ™
4PLACE FIND CHANNELS b Millivolt input &

4PLACE | FIND CHANNELS |- Discrate input -

4PLACE | FIND CHANNELS » Smart discrete input (with —

features)

eur
H
1
2
3
4
s
]
7
8
s

4PLACE | FIND CHAN&QS P Switch input (powered) ==

@QEEEEELLEHM

4PLACE | FIND CHANNELS [ Current output v
4PLACE = FIND CHANNELS |p-Voltage output -
(9
S 4PLACE | FIND CHANNELS p»DC sinking output

Replacing a Signal

1. Click the placed signal.
2. Ontheright side of the Explorer, find your new function and signal type.
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3. Click Place next to the new signal.

Click to highlight
supported signals  Placad signals

v
_ Thermocouple
> probe
* (Temperature)
(.ﬁ_ Willvoit
. +  Jdoout I
v Remove Cancel

4. C(lick Replace.

EXPORTING AND IMPORTING COMBINATIONS OF FUNCTIONS AND SIGNALS

Once you have your groov RIO configured in the Explorer, you may want to save the signal combination by
exporting it to a text file. Exported configurations can be imported later to view or work on.

Exporting
1. Toexporta combination, click Import and Export o export: Place signals on the RI0 and then click Get Description. The
. signal descriptions will appear in the text field below. Copy the text and
to expand that section. store within a text file.
To import: Paste signal descriptions (from exparting) into the field
2. C||Ck Get Descr]ption. below Glick Import. Expect a delay while the imported signals are
verified.
The Explorer places abbreviations for the functions Get Description import

and signal types in the text box. (See below for the
abbreviations used.)

3. Copy the text, paste it into a text file, and save it.

4
Note: Importing places the first & valid signals for channels 0-7 and 2 for 8
and 9.

The following abbreviations identify functions and signal types:

Inputs Outputs

ai_voltage ao_current
ai_mv ao_voltage
ai_current do_sinking
ai_ictd do_formc_no
ai_thermocouple do_formc_nc
di_discrete

di_smart_discrete

di_switch_powered

« ai—analoginput

« ao—analog output
o di—discrete input

« do—discrete output

Importing

1. Toimport a combination, click Import and Export to expand the section.
2. Paste all the text from the text file you saved into the box. Click Import Configuration.
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The RIO Explorer assigns the functions and signals to the channels, verifying that they are correct. There
may be a delay while verifying.

Note that the channels may not end up in the same order you originally configured.

You can also type function/signal abbreviations into the field, and the Explorer will place them. It uses the
first eight valid signals for channels 0-7 and the first two for channels 8 and 9. (Any text not in the correct
abbreviation format is ignored.) So for example, to import channel assignments like the first wiring
diagram on page 120, you could type the following into the text box:

ali mv,ai current,ai current,ai ictd,di discrete,di discrete,

di switch powered,ao current,do formc no,do_formc nc

WORKING WITH SAMPLES

The groov RIO Explorer comes loaded with 61,260 wiring combinations! To access those samples, click
Samples (and some fun!) to expand that section.

v Samples (and some funt)
Here is a sample configuration using a practical mix of signals:

Load Sample Configuration

To see any of the 61260 wiring possibilities, select or enter a value from
0to 61259:

0 load combination

Most combination of signals on a groov RIO can be rerranged using the
same signals but changing the channel placement.

To have the alternative arrangements calculated, choose this button.
(Expect a delay while arrangements are calculated.)

Calculate arrangements for this combination JArrangements:| v

One sample in particular can give you a good idea of the versatility of GRV-R7-MM1001-10. To see it, click Load
Sample Configuration. The Explorer replaces any signals in the Placed signals area with the signals that are in
the sample configuration.

Click ta highlight
supportes signals  Placea signals

- -
@ @ Veitage
1 nput
Smant
@ JT-' Discrete
nput
— _Themecousle
Q&=
* (Temoersture)
PR
3 probe
O —(Ye'nauamle)
Disarcte
Le
nput
@iT {aniom
@ DC Sinking Trps
[
otsge b
® [= o>
Curent
@ = o

o
e

@ Narmaly ~ M
Closeg —COM,

=]
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
oa
o a

Samples are numbered 0 to 61259. Type in any number in that range in the text box, then click Load
Combination to view that sample configuration. Have some fun with the numbers: enter a special date, the
final score of your favorite football game, or the altitude of your favorite mountain.
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How many ways are there to wire the same combination of functions and signals? For many samples
or even for a configuration that you created, the arrangement of functions and signals on the channels can be
changed. Seeing another way to wire the same signals can be useful if you have space constraints. The groov
RIO Explorer can calculate the number of ways a particular combination can be rearranged. To learn that
number and view the arrangements, click Calculate Arrangements for this Combination.

The RIO Explorer displays the result along with a drop-down list. Click the drop-down list and select any
number, and the Explorer shows that arrangement. You can scroll through the numbers by pressing the up
and down arrows on the keyboard. You'll see the Explorer update the image with each new arrangement.
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